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DESCRIPTION

This Level | training class introduces the model-based design technology in Autodesk’s Civil 3D and provides
the core for its application in civil engineering and planning projects. Over the four-day period, each student
will learn the basics of objects, styles, terrain modeling, parcels, road design, site grading, project data
sharing, gravity and pressure pipe networks, plan production, and working with survey data.
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Interface

Start Screen

Access to Learning Resources:
—  Access “What's New” Tutorials
—  Getting Started Videos

Similar to AutoCAD 2018: Familiar Environment
Multi-document enabled

Menus and Toolbars based on ease-of-use and workflow
Application Menu:

— Command Search

—  Drawing Previews

Info Center:

—  Help Search and User Documentation Access

—  Communication Center (Update Notification)
Ribbon:

— Tabs and Panels Arranged According to Workflow
—  Includes AutoCAD & Civil 3D Tools

"Sticky" Panels Can Be Detached from Ribbon

Context Sensitive (Changes with Element/Object Selection)
Toolspace:

nnnnnnn

—  Prospector Tab (Object Creation & Access, Data Shortcuts, and Templates Access)

—  Settings Tab (Style Creation & Access, Drawing Settings)
—  Drawing View Drop-Down

—  ltem View

Options:

— Command ‘OP’

—  Drawing Display Options Controlled by AutoCAD Profiles
Customized User Interface:

— Command ‘CUI

—  Controls Tool Bars and Menu Placement

View Cube:

— 3D Navigation Tool

Quick View DWG and Layouts:

—  Multiple File and Layout Preview

Active Drawing View

=7 Existing Site
Iil'@’ Points
[ﬁ‘-‘] Point Groups
@5'5 Point Clouds

Help us improve our products

‘Send Feedback

Prospector




Civil 3D 2018 Intelligence

e  Civil 3D provides powerful tools in a dynamic and intelligent environment that
streamlines the design process and increases productivity.

Intelligent Object-Based Environment

e |Intelligent AECC objects instead of basic AutoCAD entities
Example: A series of connected AutoCAD lines and arcs (AutoCAD)

RIMETER: 21

"II -------------------------- e
VS.
An intelligent Alignment (Civil 3D)
Intelligent Objects
®  Are the Building Blocks of Civil 3D Design
I . . . TOOLSPACE
e  Maintain Dynamic Relationships to Each Other Styles
q) —  Objects react to changes in other related objects e  Similar to ‘Styles’ in MS Office, i.e. a e
@) —  Parcels subtended by alignments will automatically subdivide into two parcels predefined group of display settings
(e i . i ) ) . (layer, color, linetype, size, etc.) that can - Existing Site
CD —  Profiles based on Alignments (surface profiles) will update as Alignment is be applied to objects at any time &-W General
edited
(@)) ! e  Controls the Display of Object w4 Point
" — —  Surfaces automatically rebuild when points or breaklines are added/edited Components -G Point Cloud
E e  Deletion of Objects is Permanent e  Created and Accessed through the - @ Surface
- e  Types of Intelligent Objects Include: Settings Tab on Toolspace =& S”’;“e Styles
E Points Point Groups J Isncllude Object Styles, Label Styles, Table % Border & Co...
f tyles Border & Conto...
_ Surfaces Alignments &
) Feature Lines Grading Groups e  Associated to Objects through Object - Border & Conto...
c Parcels Pipe Networks Properties (% Border & Canto..
() Corridors Profiles - (3 Border & Directi...
E Profile Views Sample Lines - (% Border 8 Grid 8.,
cC Sections Section Views 53 \ (3 Border & Triangl...
O Assemblies Subassemblies (% Border Only
o View Frames Match Lines A ~5"  Contours (ba...
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UCJ \\ ([ Table Styles
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1. Open “.\Introduction\Existing Site.dwg”

2. Change Surface Style to “Border & Contours & Triangles”
a. Select the Surface and choose “Properties” from the right-click menu or the TIN Surface contextual tab
b.  Change the “Style” to “Border & Contours & Triangles”

—=> This can also be accomplished in the “Surface Properties” dialog, as shown here:

Tin Surface

T .InFormation 'Deﬁniﬁon IlAnaIysis I|513tistics I

Lock

Style V> Border & Contours & Triangles
MName ﬁ%‘ Border & Contours
Description ﬁ% Border & Contours & Slope Arrows
Material f_% Border & Contours & Slopes

Show Tooltips ﬁhﬂ
i f_% Border & Directions k‘
ﬁ% Border & Grid & Elevations
f_hE‘ Border & Triangles & Points
f_% Border Only
ﬁ%‘ Contours (background)

14_% Standard

-y Create/Edit..

Mame:
EG

Description:

Default styles
Surface style:

ﬁ%‘ Border & Contours & Triangles - @ iv

f_% Border & Contours

ﬁ% Border & Contours & Slope Arrows
f_% Border & Contours & Slopes

¥
f_% Border & Directions

ﬁ% Border & Grid & Elevations

f_% Border & Triangles & Points

= ﬁ% Border Only

f_% Contours {background)

¥ - standard

Hyperlink

Data
MNumber Of Poi LEE
Minimum tion 60,000

Maximum Elevation 182.000'




File Formats

e  Civil 3D recognizes AutoCAD file formats including .dwg, .dwt, .dws

IoN

— .dwg: Design File Format
— .dwt: Template File Format containing standard Styles and drawing settings (Standard Templates provided with software)
— .dws: Standards File Format (a template that contains standard element samples)

e  DWG Format compatibility
— 2013 DWG format usable by AutoCAD 2013, 2014, 2015, 2016 and 2018
— 2013 Civil 3D DWG format usable by Civil 3D 2013, 2014, 2015, and 2016

—  Prior to 2013, files are not backwards compatible

Units and Zone i‘l’ransfnrmaﬁon HlDbject Layers ”lAbbrewaﬁons ulmbient Settings "

— 2018 introduces new Civil 3D Object Versions, so these drawings with

intelligent objects are not backwards compatible to any prior version. X nlg i {mperialfo Melnic converryon: Seele;
US Survey Foot(39.37 Inches per Meter)
Angular units: [ Scale objects inserted from other drawings Custom scale:
DraWing Creation [ set AutoCAD variables to match 40
. . . P . Zone
e A new project design file can be created from an existing template and will Catesorcs: -
automatically appear in Prospector e LEA, Veginla -
Available coordinate systems:
— Rick-click a template file in Prospector and choose Create New Drawing or NADS3 Virginia State Planes, North Zone, US Foot .

—  Go to Application Menu > New and choose a Template or New Drawing Icon Selected coordinate system code:  VABSNE

e  Drawing setting can be modified through the Settings Tab

Description:
MAD&3 Virginia State Flanes, North Zone, US Foot

—  Right-click drawing file name and
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A Drawing Settings - Drawingl Projection:
[T=>T . . » - :
choose “Edit Drawing Settings =
. . . |Units and Zone ﬂ ransformation | Object Layers ;Abbrewatcns ul
—  Drawing Settings include: : : Datum:
g 7 . i i NADB3
- <> Units and Zone Object Layer Modifier
C "7 alignment C-ROAD MNone
(b) Transformation T Alignment-Labeling C-ROAD-TEXT Nane
ﬁ Alignment Table C-ROAD-TABL Maone
E <> Object Layers 1 Appurtenance C-WATR-APPT MNone [ oK J [ Cancel ] [ Apply ] [ Help ]
'@ Appurtenance-la... C-WATR-TEXT MNone @
(e {  Abbreviations 25 Assembly C-ROAD-ASSM None =
O % Building Site 0 Mone EI
o ¢ Ambient Settings Cant View 0 None &
- — § Catchment C-HYDR-CTCH Mone &
> " Catchment-Labeling 0 Mone o
C Corridar C-ROAD-CORR None @&
Corridor Section C-ROAD-CORR-5CTM  Mone EI
I I I Feature Line C-TOPO-FEAT Mone o
Fitting C-WATRFITT None @&
-O ' FittingLabeling  C-WATR-TEXT None &
C "% General Note Label C-ANNO MNone ) -
CU @ Enter a single * (asterigk) in the value field to indude the abject name as the prefix or suffix value in a layer name.
_SB [ immediate and independent layer on/off control of display components




1. Create New Drawing
a. Use the + to create a new drawing tab using the “_AutoCAD Civil 3D (Imperial) NCS.dwt”

2. Change Drawing Settings as follows:

a. On the “Settings” tab of the Toolspace, right-click on the drawing name and choose “Edit Drawing Settings”
b.  Units and Zone

Drawing Units: Feet Scale: 17 =100’
Set AutoCAD Variables to Match: Checked Zone: USA, Virginia
Coordinate System: NADB83 Virginia State Planes, North Zone, US Foot

c. Object Layers

Alignment: C-ROAD (-* Suffix) Alignment Labels: C-ROAD-LABL
Assembly: C-CORR-ASSM Corridor: C-CORR

Parcel: C-PRCL Parcel Segment:  C-PRCL-LINE

Parcel Table: C-PRCL-TABL Profile: C-ROAD-PROF (-* Suffix)

Subassembly: C-CORR-ASSM
d. Abbreviations (Leave default settings)
e. Ambient Settings> General

Plotted Unit Display Type: Decimal
Show Event Viewer: No
Show Tooltips: Yes

Examine other settings and options
3. Save as new template file (C:\Civil 3D Projects\Civil 3D Class template.dwt)
Save again as “Points and Surfaces.dwg” under the same folder
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o e LA w2 ww n & Import Su = Edi y N [ pmacs
Attach Clip ljust

= _% Points from File Import Subassemblies ¢ Edit Attributes -
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I port InfraWork:

Point Import Capabilities
e Import options controlled by Point Settings and Point Command Settings Selected Files:

e 16 standard text file formats provided (comma and space delimited) File Mame Status

e  Can create your own file formats and store in drawing templates " I:\Civil 30\ evel T\2015Y4 C... Matches selected point file for...
e  Automatically add all Points to one Point Group or create new Point Group on the fly
o  Perform Elevation Adjustment

o  Perform Coordinate Transformation Spedify point file format (filtering OM):

Point Import Tools ¥YZ_RGB {comma delimited)
PME (comma delimited)
PMEZ (comma delimited)

e  Select Point File format PNEZD {comma delimited)

e  Choose Source File(s) to import

e  Found on ‘Insert’ Tab> ‘Import’ Panel> ‘Points from File’ Tool

Preview: PNEZD (comma delimited) | Site Improvements_mod. txt

e  Perform Coordinate Transformation
Point Mum...  Morthing Easting Point Elev... Raw Desc, *

1 1360040.... 76091L.0.. 145.8537
# n 2 1360217.... 760778.7... 1415097  fr
A Point File Formats - Create Group ﬁ 3 1360213.... 760781.5.. 142.0897  na
4| m |
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Enter the name of the group to create. If a group Add Paints to Paint G
already exists by this name, then it will be used. O i it

ing

Topo 05-01-20 14{ Advanced options
Do elevation adjustment if possible

Ok ] [ Cancel ] [ Help [] Do coordinate transformation if possible

Import

Do coordinate data expansion if possible

Points




1. Import Point File “..\Points\Site Inprovements_mod.txt”
a. “Insert” tab > “Import Panel” > “Points from File”
b. Use the |i| button to browse to the file listed above
c. Select the PNEZD (comma delimited) file format ey
d. Putacheck in the “Add Points to Point Group” box, then use the |[“'§’]| button to create a new Point Group called
“Topo Survey [today’s date]”
2. Examine Results
a. Zoom Extents in drawing
b.  Examine the Points in the Prospector “Iltem View”
c. Zoom to and Pan to Points
d. Manipulate labels
3. Save the Drawing
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Rl LI o RELEEDN
= ¢ Surfaces = .
: ‘n%“ Create Surface E
e e | Cre
".w’...................."
z‘ Surface Creation Tools Types I
~ e Surface Creation Tools are found on ‘Home’ [T surface ~| cToro
Ay Tab> ‘Create Ground Data’ Panel> ‘Surfaces’ i
U) - Tool or _I?‘rope.r_ﬁes i Value
(¢b) » e Right-click on Surfaces in Prospector 5 l“f:r“"’ti““ ——
ame xisting Topo
8 o Create Surface Tool Description Description
. . Style Contours 2' and 10" (Background)
t — Creates a holder for surface information Render Mateid T gy
= — Choose Surface Type
(D — Enter Name and Description
(@)) — Set desired Style and Material
(e e Additional Surface Creation Options:
E - Cr%‘altse Sutrfa(ce frng DEf"YL -;-IN' } Selecting OK will create a new surface which will appear in the list of surfaces in Prospector.
or ata (ex. Shapefiles
e Add data to Surface ok J[ o J[ neb |
A . TOOLSPACE ;
( ) e  Under Surface “Definition” in Prospector ~
" . e  Data that can be added includes: &
g —  Boundaries (Outer, Show, Hide) fclive Drawing View d 2
s —  Breaklines =8 F}v Surfaces ‘B
) Cont = (5 Existing Topo a
- ontours ;
-O fr\ Masks A
O — DEMFiles % Watersheds
E —  Drawing Objects E- (& Definition
—  Edits (TIN deletions, Paste Surface, etc...) (%) Boundaries &
- —  Point Files ?F e =B
- Contours =2
(40) —  Point Groups . 3
— (% DEM Files
GLJ Examine Surface for Errors - € Drawing Objects
I e  View in Object Viewer @ Edits
—_— — Right-click on Surface and choose “Object Viewer” ] Point Files
© —  Use multiple View Styles ~[#] Point Groups
= N es. hol 4% Point Survey Queries
)] ° ote any spikes, holes, etc... e M e
D [H-"2F Alignments




1. Continue in “Points and Surfaces.dwg”
2. Create New Surface

a. “Home” tab > “Create Ground Data” Panel > “Surfaces” > “Create Surface”
b. Name: Existing Topo
c. Description:  From Contours and Points
d. Style: Contours and Triangles
e. Material: Grass - Short
f.  HitOK
3. Add Data

a. Prospector > expand “Existing Topo” > “Definition” > right-click on “Point Groups
b. Choose "Topo [today’s date]” and hit “OK”

4. Examine in the Object Viewer
a. Look for spikes, holes, etc...

5. Edit Point Group
a. Prospector > expand “Point Groups” > right-click on “Topo Survey [todays’ date]” and choose “Properties”
b. Inthe “Exclude” tab check “With elevations matching”
c. Type “<5” and hit OK
d. Rebuild the Surface (right-click on “Existing Topo” and hit “Rebuild”)

6. Save and close the Drawing
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Annotate  Modify  Analyze _\gw ,.lWpnage Output Survey  Autodesk360  Help
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B Object Viewer
Bg Isolate Objects Pmperlkﬁ-’
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I % Breaklines *

éﬁ Contours

Breaklines

i,

m DEM Files

Breaklines

e  GIS Definition - A linear feature that defines and controls the surface behavior of a TIN in terms of smoothness and continuity.

®  Represent known features in surface (elevation breaks, edges of pavement features, stream banks, etc...)

e  Control creation of triangles and contours

—  Triangles can’t cross breaklines - creates linear features in TIN

Breakline Types

e  Standard - Defined by selection of 3D lines, grading features (covered in another class), or 3D

Polylines

e  Proximity - Defined by selection of polyline or other object inside the surface extents. The Z
value for the vertices in these breaklines is determined from the closest corresponding TIN
point.

e  Wall - Defined by selecting grading features, 3D lines, 3D Polylines or points and specifying
an offset side and elevation difference. Treated as a Standard Breakline

e Non-destructive - Defined by selecting grading features and other AutoCAD objects. These
breaklines are applied to the surface for guidance in triangle creation, but they still maintain
the integrity of the original surface.

Adding Breaklines

e  Draw ‘dummy’ features to represent breaklines

e  Select Surface to get ‘Surface’ Tab> ‘Modify’ Panel> ‘Add Data’ Tools or
e  Under Surface “Definition” in Prospector (right-click)

®  Provide Description, Type, and Mid-ordinate distance

®  Select Features

) Visibility Check -
@& Catchment Area

Surface E' Edit Surface  Water Drop Resolve Crossing : T
= ¥ Volumes Dashboard @ Extract Objects Profile @ Grading Creation Tools

Add-ins  Raster Tools  Express Tools  Featured Appa  Tin Surface: Existing Topo
] L]
@ Export to DEM ; A Create frfie======n==nunnu=s

4 Drape Image ol Eal Data Shortcut

Description:

Driveway

Type:
Standard

File link options:
Break link to file
Weeding factors

Distance: Angle:
15.00° 4,0000 (d)

Supplementing factors

Distance: Mid-ordinate distance:

100.00° '

] [ Cancel
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Open “.\Surfaces\Create Surface—Add Breaklines.dwg”
2. Add Driveway Breaklines

a. Prospector > expand “Existing Topo” > “Definition” > right-click on “Breaklines” and choose “Add”
b.  Description: “Driveway”

c. Type: Standard

d. Weeding: Off

e. Supplementing Factors: Off

f.  Mid-ordinate Distance: 0.08

g. Hit OK and choose the 4 Feature Lines that represent the driveway

3. Repeat Step 2 to add the Road Edges (Description = “Existing Road”)
Examine the Surface in the Object Viewer
5. Save the drawing
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Annotate i i Survey Autodesk360 Help Add-ins Raster Tools Express Tools Featured Apps | Geolocatiorf | Tin Surface: Existing Topo o

I' Properties * h £ Visibility Check ~ @ Export to DEM A& Create Profile CLEEEEEEEEEEEEEEEEL
% o &,

& Object Vi =
Add  Inguiry ol L 2 e ® Water Drop Resolve Crossing

@ Catchment Area 4 Drape Image E Data Shortcut
Labels Legend By Isolate Objects = 3 Breaklines ™ Volumes Dashboard  # Extract Objects Pmﬂe & Grading Creation Tools
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él—g Contours

Boundaries
e  Consist of closed polyline/polygon that controls the visibility of triangles and contours in a surface

e Used often to represent survey extents

Boundary Types
e  OQuter - Defines the outside boundary of a surface. Any surface elements (triangles, contours) outside of the boundary are not shown.

e  Hide - Defines an inner boundary of a surface. Any surface elements (triangles, contours) inside the boundary are not shown.
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e  Show - Defines an inner boundary of a surface, inside of which surface elements (triangles, contours) are shown. Useful for creating islands inside of hide boundaries.

e Data Clip - Defines a region of a surface where new data added to the surface will be used.

—  For example, if you want to add LIDAR data to only one area of a surface, you create a data clip boundary, then add the whole set of LIDAR data. Only the LIDAR data
that falls inside the Data Clip boundary will actually be added to the surface

iting

Adding Boundaries

e  Draw closed polyline/polygon to represent Boundary

e  Select Surface to get ‘Surface’ Tab> ‘Modify’ Panel> ‘Add Data’ Tools or
e Under Surface “Definition” in Prospector (right-click) Site Extents|

e  Provide Name, Type, Breakline behavior and Mid-ordinate distance Type:

| Outer

Model Ed

e  Select Features (closed polyline/polygon)

IN

Mon-destructive breakline

Quick Note . Hid—urdinate distance:

Outer Boundaries are a form of “Show” boundary. These will
show everything inside of them and override any internal
“Hide” boundaries you have.

tal Terra

The order in which boundaries are added is important. Always
add the outer boundary first.

To]

D




1.

SN

Continue in “Create Surface—Add Breaklines.dwg”
Use the AutoCAD POLYLINE command to create a closed polyline around the site (as shown below)

. Add this polyline as the Outer Boundary

Prospector > expand “Surfaces” > “Existing Topo” > “Definition” > right-click on “Boundaries” > “Add”
Name: Site Extents
Type: Outer

Non-destructive Breakline: Unchecked
Hit OK and choose the polyline

Add Hide boundaries for the Buildings

Repeat Step 3 with the following options:
Name: Buildings

Type: Hide
Non-destructive Breakline: Checked

Hit OK and choose the 3 blue building polylines

Repeat Step 4 to add the EW for the Pond (Green line) as a Hide Boundary
a. Name: Pond

b. Type: Hide

c. Non-destructive Breakline: =~ Checked

d. Hit OK and choose the green EW line

Ppoooe

poooTp

Rebuild the Surface (if necessary)
Examine in the Object Viewer
Save and close the Drawing

15



iting

™)
LLl
)
O
(©
Y
| -
-
7))

iting

Model Ed

IN

tal Terra

igi

D

Surface Editing Functions
®  Select Surface to get ‘Surface’ Tab> ‘Modify’ Panel> ‘Edit Surface’ Tools or

Surface Add Dat{ Edit Surface  WVater Drop Resolve Crossing
- n

Properties ™ 5

EEEEN *

""""""" o= [a¥" AddLine __
ﬁ_‘ Drelete Line
#,} Swap Edge
#‘ Add Point
# Delete Point
#/ dify Point

Surface Properties
e  Change Surface Build options (‘Definition’ Tab)
— Exclude elevations less than or greater than certain values
— Minimum and Maximum triangle length
e  All Edits tracked, accessed, and re-ordered in Surface Properties a

—  Turn on/off

— Delete

®  Prospector under the Surface ‘Definition’ right-click on ‘Edits’ to show all Options

e  TIN Edits e  Surface Point Edits e  Surface Object Edits
— Add Line — Add Point —  Minimize Flat Faces (Triangles)
— Delete Line — Delete Point — Raise/Lower Surface
— Swap Edge — Modify Point —  Smooth Surface
— Move Point —  Paste Surface (covered in later class)

Analyze  View Magige e e QW Survey Autodesk360 Help Add-ins  RasterTools  Express Tools

’ ) * An €Y Visibility Check ~ @ ExporttoDEM | o had Create Profile
e fy é Wy hd
@ Catchment Area 4 Drape Image Eal Data Shortcut

Quick

Breaklines ™ Volumes Dashboard % Extract Objects Profile @ Grading Creation Tools

Surface Tools v | aunch Pad

Information | Definition IAnaIysis I|Siatistics I

Definition Options

Build
Data operations
Edit operations

Operation Type

[‘1":‘-‘] Point Group
£k add breakline
Add boundary
Add boundary

Swap Edge

Swap Edge

Swap Edge

Parameters

MName: 12-21-2012 Topo

Type: Standard, Description: Driveway
Type: Outer, Description: Site Extents
Type: Hide, Description: Buildings

At (761229,2225',1359862.9653)

At (761268.6124,1359878,5802)

At (761167.0075',1359809, 3304)

nd in Prospector




1

Open “..\Surfaces\Edit Surface—TIN Editing.dwg”

2. Prepare Surface for Editing
a. Use the Properties Palette to change the Surface Style to “CADD-TIN Editing”
b. Zoom in to the area between the pond and locate the white circle labeled “A”

3. Swap Edges
a. Prospector > expand “Surfaces” > “Existing Topo” > “Definition” > right-click on “Edits” and choose “Swap Edge”

b.  Select the edge that starts near the letter A and goes diagonally NE towards the road to swap. Notice the change to
the contours

4. Move Point
a. Pantothe NW and locate the white circle labeled “B”
b.  Prospector > expand “Surfaces” > “Existing Topo” > “Definition” > right-click on “Edits” and choose “Move Point”

c. Select the TIN point near the center of circle “B” and move it slightly to the North. Again, notice the change to the
contours

5. Delete Point
a. Zoom and Pan to the South end of the driveway and locate the circle labeled “C”
b.  Prospector > expand “Surfaces” > “Existing Topo” > “Definition” > right-click on “Edits” and choose “Delete Point”

c. Select the TIN point near the center of circle “C” that corresponds to the “fir’ COGO Point. Notice that the TIN Point
is removed and the contours change but the COGO Point is not changed.

6. Save the Drawing

17
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Q Q ‘* {Aﬁr ). Visibility Check ~

5 . @ Catchment Area
Add Add  Inquiry Surface Add Data  Edit Surface  Water Drop Resolve Crossing

ol ) _Modify ! _Analyze ~

% Add Surface Labels k

% Contour - Multiple

% Contour - Multiple at Interval

Surface Labels
e  Select Surface to get ‘Surface’ Tab> ‘Labels & Tables’ Panel> ‘Add Labels’ Tools or
e  ‘Annotate’ Tab> ‘Labels & Tables’ Panel> ‘Add Labels’ Tools> ‘Surface’ or
®  Prospector right-click on the surface> ‘Add Label’
e Display based on Label Styles
e Label Types
—  Slope
—  Spot Elevation (automatic Point creation)
—  Contours
Contour Labels
e  Commands accessed from Surface menu
e Display based on Label Styles
e  Select Label creation method
—  Single Label Line
—  Multiple Labels Line
—  Create from Objects
—  Multiple Labels Line at Interval
—  Label Major
—  Label Minor
—  User-Defined Contours

e  Select locations inside the Surface

Contour Label Lines can be adjusted with a right-click and selecting ‘Contour Label Line Properties

Modil Analyze  View Manage Output  Survi Autodesk 360 Hel, Add-ins  Raster Tools  Express Tools  Featured A “Geolocation® Tin Surface:
g P! ey P P Pps

g Export to DEM u \aé Create Profile
4 Drape Image ik Eal Data Shortcut
(1]l
Labels " Legend L kolateéhjects Properties ~ i Breaklines ™ Volumes Dashboard @3 Extract Objects Profile @ Grading Creation Tools
_ Surface Tools v : h Pad

<ssssssnmmsnmnmnn’

Quick Note

Contour Label Lines can be turned off by selecting the labels,
right-click, select ‘Contour Label Line Properties’, and choose
‘False’ for the ‘Display Contour Label Line’ property.

Surface Contour Label Group

True
From Label Style
True
isting Major Labels
True
y isting Minor Labels
tour Lakbx True
r Label & ser... Existing Major Labels



1. Continue in “Edit Surface—TIN Editing.dwg” A [
2. Add Slope Labels Feature:
a. “Annotate” Ribbon tab > “Add Labels” > “Surface” > “Add Surface |surface -]
Labels” Label type:
b. Label Type: Slope [SpotEevation o
c. Slope Label Style: Percent
d. Hit “Add” Spot elevation label style: -
e. Use the “One Point” option and pick a location on the Surface % Hlevation Only i |@| |E|
f.  Hit “Add” again and use the “Two Point” option to place a two-point Marker style:
slope label somewhere on the Surface 21 Basic GrolewithCross ~ [IBB] |Fq|

3. Add Spot Elevation Labels
a. Inthe “Add Labels” dialog, set Label Type to “Spot Elevation”
b. Leave the defaults for styles
c. Hit“Add”
d. Select a location on the Surface to place the Spot Elevation Label

4. Prepare Drawing for Contour Labeling
a. Use the Properties Palette to change the Surface Style to “Contours

1’ and 5 (Background)” Reference text object prompt method:
|Command Line - |
5. Add Contour Labels
In the “Add Labels” dialog, set Label Type to “Contour-Single” | Ad || Cose |[ Hep |
Leave the defaults for styles
Hit “Add”

Select a location on a contour to place a single contour label Spot Elevation Label

Back in the “Add Labels” dialog, change the “Label Type” to “Contour—Multiple” and hit “Add”.
Pick multiple locations to define a polyline (contour label line) that crosses multiple contours.
g. Close the “Add Labels” dialog

) >
6. Use the instructions in the Quick Note on
the previous page to hide the Contour
Label Line
7. Select one of the Contour Labels and use o
the grips to edit the placement %;\
8. Save the Drawing /\/ cﬂ%@g
)
=
*\DQ
Cb%
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\
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Data Management

Data Sharing With Data Shortcuts

Ability to Share Objects between drawings without the need for a database

MR RN ). e el L L LR R L LR

.
Sharable Objects Include: E

—  Surfaces E"_re
— Alignments :’ =
—  Profiles

—  Corridors

—  Pipe Networks (Gravity and Pressure)

—  View Frame Groups

Links to Objects created from one drawing to another

— References generated as separate XML files
Referenced Objects can be used in Destination Drawing
—  Change Display and Labels through Styles

— Useintelligence

—  Geometry can only be edited in original drawing

Working with Data Shortcuts

‘Manage’ Tab> ‘Data Shortcuts’ Panel

All Data Shortcuts stored in a Data Shortcuts Folder

—  Project Templates can be used for automatic folder generation
— XML files as well as Drawings can be stored

Can have multiple Data Shortcut Folders

Can convert Data Shortcuts to Vault

— Import into Vault

— Automatically converted to Vault References

Creating Data Shortcuts

Create New Folder

—  ‘Manage’ Tab> ‘Data Shortcuts’ Panel> ‘New Data Shortcuts Folder’

—  Select Project Template (optional)

—  Current Data Shortcuts folder will be automatically set to newly created folder
Create Data Shortcuts

—  Create shortcuts for data in the current drawing

—  ‘Manage’ Tab> ‘Data Shortcuts’ Panel> ‘Create Data Shortcuts’
—  Choose objects to share

—  Shortcuts will appear in Prospector

Original Drawing that holds the object is called the “Source Drawing”

[=]

ate Data
rtcuts

New Shortcuts Folder Bl Manage Data Shortcuts

Wiy Set Shortcuts Folder Validate Data Shortcuts
o

il 5Set Working Folder E Synchronize References *

ction Recorder

TOOLSPACE
n -
Master Vi ~ =
aster View g
= Open Drawings &
: [=]
[ Alignments - Create Alignments L... =%

[—J--IE Data Shortcuts [ChCustom Civil 30 201,
ﬁ% Surfaces

':E Alignments

ﬁ% Pipe Metworks

% Pressure Metworks

“[E} View Frame Groups &
- [wt] Drawing Templates

ttin qs

SE

i’

Creating Reference Objects

Access Destination drawing

—  Open another drawing or Create a New Drawing

—  Destination drawing sometimes referred to as the “Consumer Drawing”
Add Reference copy to Destination drawing

— Make sure the correct Data Shortcut Folder is set

— Right-click on Data Shortcut Object in Prospector and choose “Create
Reference”

— Provide a name, starting Object Styles, and other information for object in the
destination drawing.

Quick Note
If the drawing is new, it must be saved before
reference objects can be added




EXERCISE NOTES

1. Continue in “Edit Surface—TIN Editing.dwg”

2. Set Working Folder to C:\Civil 3D Projects\Civil 3D 2018 Level \Data Management
a. “Manage” Ribbon tab > “Data Shortcuts” Panel > “Set Working Folder”
b. Browse to the path listed above
c. Hit“OK”

3. Create New Data Shortcuts Project Folder
a. “Manage” Ribbon tab > “Data Shortcuts” Panel > “New Shortcuts Folder”
b. Name: “<YYYY-MM>_Hunter's Ridge” (use current month and year)
c. Leave the other defaults and hit “OK”

4. Create Data Shortcuts
a. Save the drawing
b.  Prospector > scroll down to “Data Shortcuts...”, right-click and choose “Create Data Shortcuts”
c. Putacheck in the box for “Existing Topo” and hit “OK”

5. Create New Drawing by selecting the New Tab “+”
a. Save the new drawing as C:\Civil 3D Projects\Civil 3D 2018 Level \Road Design.dwg”

6. Create Reference to the Surface in the New Drawing
a. Prospector > expand “Data Shortcuts...” > “Surfaces” > right-click on “Existing Topo” and choose “Create reference”
b. In the dialog that appears, set the Style to “Contours 2’ and 10’ (Background)” and hit “OK”

7. Examine the Prospector to see the new Surface Reference in the drawing
8. Use Zoom > Extents to see the Surface

Save the Drawing T
are Data
Selected objects will be accessible to all users who point to the same working
= folder. These shortcuts are available in the Prospector.
Q)
v When you create a data shortcut of a comridor, data shortcuts are automatically
created for its baselines.
Object Status Description
= (T [ Surfaces
C\EI [[] Existing Topo From Contours and Trian...
@| Pick in drawing OK | | Cancel ‘ | Help
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Home |mnsert Annotate Modify  Analyze  Vigwa « Mapages « JJutput  Survey  Autodesk 360 Help  Add-ins
n

.
mm - Import Survey Data a Parcel - 5 i Intersections = i.f Profile View ~
Fjﬁ@ ¥ Paints ~ Feature Line = " ple Lines

gnment Creation Tools

F B & Sufaces - Grading ~ on Views ~
Palettes ~ Create Ground Data ~ ate Best Fit Alignment section Views

Create Alignment from Objects

Create Alignment from Corridor

Create A"gnment Create Alignment from Metwork Parts
®  From Objects (lines, arcs, polylines)

. Create Alignment from Pressure Network
e  From Corridor .

° Alignment Layout Tools Create Alignment from Existing Alignment

—  Tangent-Tangent with or without Curves

—
_J7 Create Offset Alignment

—  Free, Floating, and Fixed lines and curves
—  Free and Fixed Spirals ___ Create Widening
— AddPI
®  Must specify Alignment Type, Site, Alignment Style, Layer, and Label Set
e  Alignment Types include Centerline, Offset, Curb Return, or Miscellaneous
®  Can use Design Criteria to aid in the design process
—  Pre-defined AASHTO Tables for Minimum Radius, Transition Length, and Superelevation

—  Can build custom tables

Object Intelligence
e  Labels created on the fly
e  Layers created on the fly

e Any Parcels that are split by Alignments on the same Site will automatically be subdivided.

|h Create Alignment - Layuu't @ ||

MName:
Spaniel Dr.

Type:

“Z3 Centerline

Description:

Alignment Layout Tools - Spaniel Dr. : : : el @ o
Select a command from the layout tocls Spiral Type: Clothoid
Quick Note

This symbol indicates that a design criteria requirement has
‘I,-"i\,', not been met. Place your mouse over the symbol for more
information.

General | Design Criteria

Starting station: ~ 0+00.00'

Site:

By <Mone>
Alignment style:
o
Alignment layer:

C-ROAD

Alignment label set:
(FE‘J Major Minor and Geometry Points

-] [l
- B E
- B E

[ OK i [ Cancel

J |

Help ]




1. Continue in ‘Road Design.dwg”
Insert “.\Alignments\Alignments—Alignment Creation.dwg” as a block at 0,0,0 and Explode
Create Alignment from Objects

a. “Home” Ribbon tab > “Create Design” Panel > “Alignment” > “Create Alignment from Objects”

b.  Select the red polyline on the west side of the site and hit <ENTER>

c.  Make sure the direction is south to north and hit <ENTER>

d. Name: Retriever Road

e. Type: Centerline Alignment Layout Tools - Spaniel Dr,

f Alignment Style: Proposed & - o A e b
g. Alignment Label Set: Major and Minor Only - A é H\' - S E
h.  Add curves between tangents: R = 200’ Tangent-Tangent (Mo curves)

i Erase existing entities: Checked v 3

J Hit OK /T Curve and Spiral Settings...

4. Create Alignment by Layout

a. “Home” Ribbon tab > “Create Design” Panel > “Alignment” > “Alignment Creation Tools”

b. Name: Spaniel Drive

c. Type: Centerline

d. Alignment Style: Layout

e. Alignment Label Set: Major Minor & Geometry Points

f On the “Design Criteria Tab”, set the “Starting Design Speed” to 25 mph and check the box next to “Use criteria-
based design”

g. HitOK

5. Draw Alignment _

a. Inthe Alignment Layout Tools toolbar, - EGO
select the down-arrow of the first button e Q
and choose “Curve and Spiral Settings” F O =

b. Make sure “Curve” is checked and set the
default radius to 250’, then hit OK

c. Click on the down-arrow of the first button ‘

again and choose “Tangent-Tangent (With \
curves) / D,
d. Use the centersnap to snap to each of the g ; //l
circles in order from A to F, then hit J / V4
<ENTER>
e. Close the Alignment Layout Tools toolbar .,
6. Save the Drawing vy .:
Note: Most Design warnings will be fixed in the |~ 4 O\ r 5
next exercise . .
‘.\ i
\ i
4 |
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Home Insert  Annotate  Modify Analy;e- Tew" " 1u!a'n5§'e' = DUEPLE " "Sufvey " "AtSdeSb0s Help Add-ins  RasterTools Express Tools  Featured Apps | Geolocation ® Alignment: Spaniel D
e L.

0]
‘ - - f Bl Properties ] Q 9] Iu h Surface Profile = Intersection
3 5
1 #® Object Viewes _ . . . = f"‘ .- Profile View i Corri
Add _ Renumber Inquiry : n Alignment ation g Sight Distance Drive  Station
Labels Tables Tags By lolate Objecfs  Properties i eria Editor Tracker Offset Alignment [y Data Shortcut
.

sssssssssssssssssssssnnmnnnnnnnns® lyz

rse Direction

we to Site
Alignment Editing
e  Grip Edit

—  Shift Entities

—  Move/Drag Labels
®  Select Modify Tab> Design Panel> Alignment Tools or
e  Select the Alignment on screen to activate Alignment Tab on the Ribbon

—  ‘Geometry Editor’ to invoke Alignment Layout Tools

e Insert/Delete PI Quick Note
This symbol indicates that a design criteria requirement has
e  Tabular Edit ‘.-"i'-., not been met. Place your mouse over the symbol for more
— Values in Black can be edited i
—  Values in Grey are fixed
e  Sub-entity Edit
—  Edit one Sub-entity at a time
— Same rules as tabular edit Aﬁgnment'LayoutTonis_—gpaniefDl. ,..------_-----_----------M
—  ‘Design Criteria Editor’ A N B T8 | Aoy WAt O 3 S [ A B | i AR
Object Intelligence Select a cornmand from the layout tools Sp|ra! Type: Clothoid 0
e Alignment geometry updated when tabular changes are made Trememmmseneaes ; TmmRmmmemEns
o  All labels update automatically Alignment E-diting Tools

e  All tangents update automatically as curves are edited.

)
=

]
c

ES

Tangency Constraint Parameter Constrai... Parameter C... Length i Direction Start Station  End Station  Delta angle Chord length

Mot Constrained (Fixed) Two points 7.15 N47= 00" 57°W 0-+00.00" 0+07.15'

Constrained on Both Sides (Free) Radius 40,69 .00 0+07.15' 0+47.83 46,6254 (d) 39,57
Mot Constrained (Fixed) Two points 313.37 MNO® 23 26™W 0+47.83' 3+61.20'

Constrained on Both Sides (Free) Radius 215.08' .on' 3+61.200 5+76.28' 41,0764 (d) 210,50
Mot Constrained {Fixed) Twe points 395,96 M40® 41' 09°E 5+76,28' 9+72.24

Constrained on Both Sides (Free) Radius 248.08' .ag 9472.24 12+20,30' 56.8522 (d) 235.01
Mot Constrained (Fixed) Two points 59.63 M16% 09" 59"W 12+20.30' 12479.94

Constrained on Both Sides (Free) Radius 367.97 .00’ 12+479.94 16+47.90' 93,7015 (d) 328.31
Mot Constrained {Fixed) Two points 169,91 S70°07 56"W  16+47.90 18+17.81

[T

: Ed

Alignment entiti

i
2
3
4
5
8
7
8
9
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1. Continue in ‘Road Design.dwg”

2. Girip Edit the Alignment
a. Select the SPANIEL DR. Alignment to display the grips
b.  Zoom into the area near circles E and G

c. Select the grip for the Pl inside of circle E and move it to
the center of circle G. Notice that the curve remains
tangent to the lines and the labels updated
automatically.

3. Edit Alignment Through Tabular Editor

a.  With the Alignment still selected, go to the “Alignment”
contextual tab and on the “Modify” Panel, choose
“Geometry Editor”

b.  When the Alignment Layout Tools toolbar
appears, select the “Alignment Grid View” button E

c. Change the radius of the first curve to 50’
d. Change the radius of the second curve to 300’
e. Change the radius of the third curve to 250’

f. Change the radius of the last (4th) curve to 225’

4. Save the Drawing

Mao. smeter C... Length Radius Minimum Radius Design Speed Direction

M47e 00" 57

0 points 7.1% 25 mith

adius & 50.00' 154.00° 25 mi/h

MU 23 Jo

Alignment entities

300.00° 154.00"

250.00° 154.00"

250.00' 154.00"
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Alignment Styles Create/Edit Styles - Multiple Commands

e  Control display properties of Alignments e Alignment right-click menu (drawing or
Prospector)

L . . TOOLSPACE
—  Visibility of elements (lines, curves, spirals, Pls, etc..)

—  Grip Edit behavior e Alignment Properties dialog (right-click from

drawing or Prospector)

Active Drawing Settings View -

e  Create one for each Alignment type e Settings Tab (right-click)
*  Civil 3D templates contain pre-made styles o  Create New or Copy Existing and rename - Alguments - Create Algmcnts Lab_fS
'ifi'ﬁn' General
. @ Point
Alignment Label Styles Apply Alignment Styles Point Cloud
e  Controls individual element labels (Geometry Points, Segments, e Alignment Styles are applied through & surface
Curves, Stations, etc...) Alignment Properties 55 Parcel
e  Control display properties of Alignment Label Elements e Can change Styles using Prospector ltem % Grading
—  Text Style, Orientation View = 3 Alignment
—  Label visibility e  Change Label Styles BE Ij_ﬂltlignment Styles
—  Linetype, Lineweight —  Right-click on Alignment in drawing or om Basic 3

prospector, hit “Edit Label Style”

—  Content and layout of text

—  Also from Alignment Properties dialog Intersection Basic

—  Text height, color, justification . L
9 ! —  Change settings inside the Style Laynyit
— Dragged state of label (leader creation, arrowhead, etc...) Offzets
Proposed

e  Create one for each label type/setup you need
#-[Z Design Checks

e  Civil 3D templates contain pre-made styles
P P ¥ E-[ZF Label Styles

£ B Label Sets
Alignment Label Style Sets @7 _Nolabels T

All Labels

Majer and Minor o...
Major Minor and G...
<|_'—f!J Major Minor H+V Geo...
<|_'-|'::| Major Minor H+V Geo...

e  Collections of Label Styles

7))
9
>
—
(7))
Q
@)
@©
I_
©
-
©
[o)
@)
qv]
-l
-

o  Allows multiple Labels to be assigned to Alignments easily

e  Can save and import Label Sets into Alignment Properties

e  Civil 3D templates contain pre-made Label Style Sets

ignmen

e  Civil 3D templates contain pre-made styles

[+ [Z Station
. Alignment Table Styles [-[(E Station Offset
< e  Controls tables for Lines, Curves, Spirals, and Segments - [ZF Line
e Control content and display properties of Alignment Tables -2 Curve
PP B[ Spiral
(7)) —  Text Style for titles, cells, etc... ; .
e #-[Z Tangent Intersection
C —  Column content #-[== Point of Intersection
G) —  Cell Formatting (Text wrap, Sort) - [Z Table Styles
E —  Visibility of elements E-Zr Commands =
C 4 | 1 | 3
e  Create one for each Table type/setup you need EEEEEEEEEEEEEEEE——




1. Continue in ‘Road Design.dwg”

2. Change the Style of SPANIEL DR.
a. Select the Alignment and open the Properties Palette
b.  Change the “Style” to “Proposed”
c. Hit <ESC> and close the Properties Palette

3. Edit the Settings for the Labels on SPANIEL DR.
a. Select the Alignment, right-click and choose “Edit Alignment Labels”
b.  Change the Style of the Major Stations to “Perpendicular with Tick”
c. Hit Apply and review the changes in the drawing

4. Create a New Label Set
a. Hit“Save label set..”
b.  On the “Information” tab, change the name to “CADD Class—Major Minor & Geo Pt 25”
c. Hit OK, then hit OK again to close both of the dialog boxes

5. Apply the new Label Set to RETRIEVER RD.
a. Select the Alignment, right-click and choose “Edit Alignment Labels”
b. Inthe dialog, hit “lmport Label Set” and choose the set that was created in the previous step.
c. Hit OK, then OK again to apply the changes and close the dialog boxes
d. Hit <ESC> to deselect the Alignment

6. Save the Drawing

A Alignment Labels - SPANIEL DR. (=18 & |
Type: Major Station Label Style: o
‘MEJDI' Stations v| 'f,f—'é‘ Parallel with Tick - B? 'l I@l | Add > | l&‘
Type Style Increment Startsta... End station Geometr... Profie
Major Stations Perpendicular with Tick £ 100.00° 0+00.00 18+05.35
Minor Stations Tick & 25.00' F
Geometry Points Perpendicular with Tick and Ié;g +05, 35 E
b T 3
Station index increment:
100,000 Import label set... ‘ | Save label set... ‘
OK | | Cancel | | Apply | | Help |

27



0
Q@
o)

©
|_
o

ing an

Label

Alignments

Alignment Labels
e Can add Labels independent of Label Style/Set assigned to Alignment
e  ‘Annotate’ Tab> ‘Labels & Tables’ Panel> ‘Add Labels’ Tools> ‘Alignment’
e Display based on Label Styles
e |Label Types
—  Station Offset - Fixed Point
—  Station Offset
—  Single Segment
—  Multiple Segment
—  Tangent Intersection
—  Multiple Tangent Intersection
®  Pick Alignment
e  Select locations along the Alignment

Quick Note

Alignment segments must be labeled in order for them
to appear in a table.

Alignment Tables
e Each segment has a Tag
— Used as index in Table
e  Annotate’ Tab> ‘Labels & Tables’ Panel> ‘Add Tables’ Tools> ‘Alignment’
e Display based on Table Styles
e  Table types
— Line
—  Curve
—  Spiral
—  Segment (All 3 above)
e  Select Segments individually or by Style
—  If by Style, can automatically add new segments created with that Style
e  Can set options for splitting the Table

e  Set reactivity mode (Static or Dynamic)

Insert; Annotate

-A....M
7
L £ A
Labels " § Tables Text B 02000 -

Canmnns
Surface

Figure

Parcel

Feature Line

Alignment % Add Alignment Labels
% Add/Edit Profile Labels % Add/Edit Station Labels
% Add Intersection Label ¥ Station/Offset - Fixed
% Station/Offset

Catchment

Si 5
Pipe Network % Single Segment

iple 5
Pressure Network ® Waligle Scoments

% Point of Intersection
Profile View
% Multiple Point of Intersection

% Add Projected Object Label
% Add/Edit Sample Line Group Labels

Section View

Line and Curve

% MNotes

 SEREEEENEE

Annotate = Modify

A LLLE LT

i Add Point Table
§88 Add Surface Legend Table
Figure
Parcel
Alignment §8f Add Line

Pipe Network 88 Add Curve
Pressure Network 88 Add Spiral

Volume g8 Add Segment

Line and Curve




1. Continue in ‘Road Design.dwg”

2. Add Segment Labels to the Alignments

a. “Annotate” Ribbon tab > “Add Labels” > “Alignment” > “Add Alignment Labels”
b. Label Type: Single Segment

c. Leave the defaults for Styles

d. Hit “Add”

e. Click anywhere on one of the line segments of SPANIEL DR.

f.  Click anywhere along one of the curve segments of SPANIEL DR.

g. Change the “Label Type” to “Multiple Segment” and hit “Add”

h.  Click anywhere along RETRIEVER RD.

i.  Close the “Add Labels” dialog box

3. Create a Curve Table
a. “Annotate” Ribbon tab > “Add Tables” > “Alignment” > “Add Curve”

b.  Under “Select by label or Style”, change the “Section Rule” on the first row to “Add Existing and New” and put a
check in the box under “Apply”

c. Leave the remaining defaults and hit OK.
d. Click somewhere outside of the site, near the NE corner to place the table

4. Add Another Curve Label and Update the Table
a. Repeat #2, steps a—f above to place a label on another curve along SPANIEL DR., then close the dialog box.
b.  To update the table, type “REA” at the command line and hit <ENTER>

5. Save the Drawing

Curve Table: Alignments
Curve # | Radius | Length | Chord Direction Start Point End Point
C1 250.00 | 408.85 | N63" 01" 01.42"W | (761823.40,1359881.46) | (761498.33,1360046.97)
A Table Creation B (761055.09,1358938.65)
Table style: Table layer:
3 Radius Length Chord Start and End Paint - =] (=) C-ROAD-TABL =]
Select by label or style: | Split table
Label Style Name Selection Rule Apply Maximum rows per table: 20
@_'E‘Nignment curve: Deltao.. Maxdimum tables per stack: 3 :
?‘5‘ | E Offset: 0.5000"
<
@1@) il Tile tables: @ Across Down
@ O
f'%‘ ] Behaviar
é_’#ﬂ E Reactivity mode: Static @ Dynamic
<[
@ O
|ﬁ[}| Mo tags selected.
OK | | Cancel | | Help
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Profiles

Home flnsert  Annotate  Modify  Analyze View  Manage Output Survey  Autodesk360 Help Add-ins  Raster Tools  Express Tools

AR RN RS

'@m M Import Survey Data o} Parcel ~ .‘..L;_f.dlignmnt' i S e D S Move () Ro
i E ¥ Points ~ Feature Line Profile ~ = - -0 - - .‘ll

W & ér Sufaces ~ I Cenking s _. A Create Surface Profile : & - 1:{ = a el
Palettes Create Ground Data « — MY

-
h___‘ Profile Creation Tools

Create Best Fit Profile

.
. s
Quick Note eate Profilg

Profiles cannot be displayed in the Alignment: Select surfaces:
drawing without a Profile View. "2 SPANIELDR. - isti
9 M Quick Profile L

Station range

Alignment:
“ Create Super Start: End:
0+00.00" 18+05.35'

Profile Concepts

P\

[} Create Profilel .

: i ; i) 4 Create Profile flo=vic” I [¥] sample offssts:
e  Profiles are linked to Alignments e 0400.00 TSSIEE Ey

B

-10,0,-10 Add= =

(] Profiles reside in Profile Views

Profile list:

—  Separate Objects

Station
Start End M...

Existing ... Existing T... Dynamic Ewisting ... 0-+00.00° 18+05.35 130.
Existing ... Existing T... 0.00' Dynamic Existing ... 0-+00.00° 18+05.35 130.
Existing ... Existing T... Dynamic Existing ... 0-+00.00' 18+05.35 130.-

Elev:

Mame Description  Type Data Sou... Offset Update ... Layer Style

—  Profiles and Profile Views each have Styles

e  Create Profile from File, from Surface, or using the Profile Layout Tools

Create Profiles from Surface

e  ‘Home’ Tab> ‘Create Design’ Panel> ‘Profile’> ‘Create Surface Profile’

L

®  Generate Profile Definition
—  Select Alignment
—  Select Surface
—  Set station range
—  Add to list of defined profiles for the

Draw in profile view

0 upe 3 e um  spa  aym o e vim  wm s wem o0 oy
alignment
—  Choose style, offset, layer, etc...
o  Place Profile in Profile View pe—
—  All profiles are displayed in Profile Views E i ] ] =TT o
— Available from the Create Profile from L= ] T .
Surface dialog or in the Profiles menu = ] il
—  Select Alignment, Profile, station range,
styles, band sets, etc... i
» : =



EXERCISE NOTES

1. Continue in ‘Road Design.dwg”
2. Sample Surface Profile for SPANIEL DR.

a. “Home” Ribbon tab > “Create Design” Panel > “Profile” > “Create Surface Profile”
b.  Alignment: SPANIEL DR.

c. Surface: Existing Topo

d. Sample Offsets: Checked, enter -10,0,10 in the box

e. HitADD>>

f Do not close the dialog

3. Draw in Profile View

Hit “Draw in Profile View”

Set the “Profile View Style” to “Full Grid” and hit “Next >*

Leave the defaults for Station range and hit “Next >*

Leave the defaults for Profile View Height and hit “Next >*

Uncheck both of the offset Profiles (leave only the middle one checked)
Confirm that the “Labels” column is set to “_No Labels” and hit “Next >*
Set the Band Set to “_No Bands” and hit “Create Profile View”

Select a location to the East of the site to place the Profile View

S@ "0 a0oTD

4. Save the Drawing

A Create Profile View - General I . %

» General Select alignment:
"2 SPANIEL DR. - |EG|
Station Range T
Profile view name:

Profile View Heiaht <[Parent Alignment(CP}] = <[Mext Counter(CP)] = |@|
Profile Display Options Description:
Data Bands Profile view style:

iy Full Grid - ([~ ]

Brofile Hatch Options Profile view layer:

C-ROAD-PROF-VIEW =]

Show offset profiles by vertically stacking profile views

Mext = | | Create Profile View | | Cancel | | Help
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Home 2lnsert  Annotate Modify Analyze View Manage Output Survey  Autodesk360 Help Add-ins  Raster Tools  Express To
m M Import Survey Data & : - i ha" Profile View - : f’a ] +E-I Move

=t Points ~ i r : ile - 8 e e ® 9w -6 o
ar gr Surfaces - - Section Views ~ & - B - R Steetch
Palettes « Create Ground Data — Profile & Section Views Draw

-
L.‘ Profile Creation Tools

: " EEENETREIE

(D Create Best Fit Profile
) Alignment:
GCJ w Create Profile from File '::}Span|el Dr. Tl G::“
E Mame:
c ertical Alignments g Quick Profile <[Profile Type] > («[Next Counter(CP)] =

Vertical Ali t: M Quick Profile [Profi 1= (<N {CP)] =) 1
®)) . ‘Homse’ Tab> ‘Create Design’ Panel> ‘Profile’> ‘Profile Creatio Yy Description:
ml— Tools “ Create Superimposed Profile —
< e  Very similar to Alignment Layout Tools o
- ° Create Profiles in an existing profile view !u Create Profile from Corridor
© —  Select Profile View —
&) . General | Design Criteria
= —  Select Alignment
": —  Provide a Name Profile style:
m - Select the Style S\;ﬁ

Diesign Profile - [~

> —  Select the Label Set _E;E“ I i
N—" Profile layer:

e  Creation Tools 5 -
8 —  Tangent-Tangent with or without Curves C-ROAD-PROF
e —  Fixed Lines Profile label set:
Y — Add 3 different curve types ;

¢ Complete Label Set -
8 —  Tabular PVI and Curve generation <'1E)' e = @
D_ ®  Can use Design Criteria to aid in the design process
—  Pre-defined AASHTO Tables for Minimum K

= —  Can build custom tables
(@)
7))
(b} Object Intelligence
D e  |abels are automatically generated i QK I [ Sonee ] [ Help l
ED' ® |Layers can be automatically created W
O Profile La],ruut Tools - .S'panir-éi:l}r. FG [i} T
[ i A & ¥
= We BN Sear LYY S % S BDE| D
DL_ Select a command from the layout tools PVI based




EXERCISE NOTES

1. Continue in ‘Road Design.dwg”

2. Insert “.\Profiles\Profile Creation Guides.dwg” as a block, choose Explode, insert using the bottom left
corner of the profile

3. Initiate Creation Command

a. “Home” Ribbon tab > “Create Design” Panel > “Profile” > “Profile Creation Tools”
b.  Select the SPANIEL DRIVE Profile View

c. Alignment: SPANIEL DR.

d. Name: SPANIEL DR. FG

e. Profile Style: Design Style

f.  Profile Label Set: Complete Label Set

g. HitOK

4. Set Curve Parameters
a. On the Profile Layout Tools toolbar, choose the arrow next to the first button and select “Curve Settings”
b.  Make sure the “Select Curve Type” is set to “Parabolic”
c. Setthe Length to 200’ for both Crest curves and Sag curves and hit OK.

5. Create the Profile Geometry

On the Profile Layout Tools toolbar, choose the arrow next to the first button and select “Draw Tangents with Curves”
Use a “Center” OSNAP to snap to the center of Circle A to set the first PVI

Use the “Profile Grade Station” Transparent Command to set the next PVI at a grade of 2% at station 2+80.

Hit <ESC> once.

Use a “Center” OSNAP to snap to the center of Circle B to set the third PVI

Use the “Profile Station Elevation” Transparent Command to set the next PVI at station 12+00, elevation 140’

Hit <ESC> once.

Use a “Center” OSNAP to snap to the center of Circle C to set the final PVI.

Hit <ENTER> to end the command

“T@m0o0UToD

Close the Profile Creation Tools toolbar.

Save the Drawing
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Home Insert Annotate Modify Agsiyres = dscns = s hamages = s@Gutputs s eurvey  Autodesk 360  Help  Raster Tools  Express Toolsy  Profile: Spaniel Dr. FG (1)
e e e

_C3an
« % I'i Bl Properties

: v
: u Q_ o I o 12 Draw Parts in View i Corridor
i ; F & _'ﬂ = i % u Project Objects To View [ Data Shortcut
Edit Profile  Add View _ Inquiry Profi ok netry Design Crite - Profile \ﬁm' Sight Distance Drive  Station = Horizontal
Labels Labels By kolate Objects  Properties Editor = Properties Tracker Changes %4 Superimposed Profile
|

_Labels General Tools ~ % Madify Prafile o Modify View | Analyze Notifications Launch Pad

AzsmsssmssEEEN Eissssmmns

L]
% Object Viewen

| Alignments)

Profile Editing
e  Grip Edit
—  Shift Entities
—  Move, Drag Labels

ICa

(] Insert/Delete PI
e  Tabular Edit

—  Edit Curve information

¥ PVI based

—  Edit PVI station, elevation, grade in, grade out. b
—  Grid View can be PVI- or Entity-based i based

— Values in Black can be edited
—  Values in Grey are fixed
e  Sub-entity Edit

—  Edit one Sub-entity at a time Quick Note

—  Same rules as tabular edit ~ This symbol indicates that a design criteria

_3 requirement has not been met. Place your mouse
over the symbol for more information.

T
)
2
0
Q9
=
@)
S
al
c
R
0
[
a

Object Intelligence
e  Profile geometry updated when tabular changes are made

o  All labels update automatically

1ilgle

e  All tangents update automatically as curves are edited.

Edi

Profiles




Profile Entities

Continue in ‘Road Design.dwg”

Grip edita PVI
a. Select the blue Profile line to display the grips

b.  Use the center (upright) triangle on the second PVI to shift the PVI to the center of Circle D. Notice that the labels
update their position and information automatically.

Edit the Profile Through Tabular Editor

With the Profile still selected, go to the “Profile” contextual tab and on the “Modify” Panel, choose “Geometry Editor”
When the Profile Layout Tools toolbar appears, select the “Profile Grid View” button

Change the “Grade Out” from PVI 3 to 1%

Change the “Profile Curve Length” of the curve at PVI 3 to 250’

Change the “Grade Out” from PVI 4 to 1.5%

Close the “Profile Entities Panorama” and the Profile Layout Tools toolbar.

© Q0T o

Save the Drawing

l@&)%

Mo, PVI Station PVI Elevation Grade In Grade Qut A (Grade Change) Profile Curve Type Profile Curve Lengt

0+00.00' 131.48' 1.00%

248489 134,33 1.00% 0.50% 0.50% Crest 200,00
8+64.95' 137.23 0.50% 1.00%: 0.50% Sag 250.00'
12-+00,00° 140.58' 1.00% 1.50% 0.50% Sag 200,00

L1 A R X e

18+17.81 149,85

1L
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Profiles

Profile Styles

Control display properties of Profiles
— Visibility of elements (lines, curves, spirals, Pls, etc...)
— 3D Chain Visualization

Create one for each Profile type

Civil 3D templates contain pre-made styles

Create/Edit Styles - Multiple Commands

Profile right-click menu (drawing or Prospector)

Profile Properties dialog (right-click from drawing or Prospector)
Settings Tab (right-click)

Create New or Copy Existing and rename

Profile Label Styles

Controls individual element labels (Geometry Points, Lines,
Curves, Stations, etc...)

Control display properties of Profile Label Elements

—  Text Style, Orientation

—  Label visibility

—  Linetype, Lineweight

—  Content and layout of text

—  Text height, color, justification

—  Dragged state of label (leader creation, arrowhead, etc...)

Create one for each label type/setup you need

Civil 3D templates contain pre-made styles

Profile Label Style Sets

Collections of Label Styles
Allows multiple Labels to be assigned to Profiles easily
Can save and import Label Sets into Profile Properties

Civil 3D templates contain pre-made Label Style Sets

Apply Profile Styles

Profile Styles are applied through Profile Properties

Can change Styles using Prospector Item View

Change Label Styles

—  Right-click on Profile in drawing or
prospector, hit “Edit Label Style”

—  Also from Profile Properties dialog
—  Change settings inside the Style

TOOLSPACE

Active Drawing Settings View

-

ﬁﬁﬁ‘ General

% Point

+-@ Point Cloud

E“‘,’ Surface

%ﬂ Parcel

® Grading

Z% Alignment

- Profile

=B Profile Styles

:‘{3 Basic

----\'{EP Design Profile
Existing Ground Profile

e
""\_'{EP Intersection Basic
e

.

Layout
- Left Sample Profile
- Right Sample Profile
[+-[Z Design Checks
=== Label Styles
OB Label Sets
(','E,JP _MNo Labels
: (];P Complete Label Set
B-[& Station
--IE? Major Station
--IZ‘;P Minor Station

[+ [Z Grade Breaks
H- (& Line

& [Z Curve
#-[Z Commands

B fuf Profile View

i o

- Horizontal Geometry Point

=-[ Profiles - Create Design Profile - Finished &

m

:"-!:iE':tl

o
P




1. Continue in ‘Road Design.dwg”
2. Change the Style of SPANIEL DR. FG

a. Select the Profile and open the Properties Palette

b.  Change the “Style” to “Layout”. Review the changes in the drawing
c. Repeat steps a—b to change the Profile Style back to “Design Style”
d. Hit <ESC> and close the Properties Palette

3. Edit the Settings for the Labels on SPANIEL DR.
a. Select the Profile, right-click and choose “Edit Labels” I
b.  Select the “Grade Breaks” line and hit the “X” button to remove them @‘
c.  Change the “Dim Anchor Opt” for Crest Curves to “Distance Above”
d. Change the “Dim Anchor val” for Crest Curves to 2.0”
e. Change the “Dim Anchor val” for Sag Curves to-1.0"
f.  Hit Apply and review the changes in the drawing

4. Create a New Label Set
a. Hit“Save label set..”
b.  On the “Information” tab, change the name to “CADD - Lines and Curves”
c. Hit OK, then hit OK again to close both of the dialog boxes

5. Save the Drawing

A Profile Labels - SPANIEL DR. FG = rah

Type: Profile Major Station Label Style: —
|Major Stations o | éfé Perpendicular with Tick > “_i‘d? '| “_qu| | Add> > | | ® |

Type Style Increment Start sta... End station Dim anchor opt  Dim anchor val  Weeding
Lines Percent Grade & 0 ' Distance above  3.00007 0.00'
Crest Curves Crest & Sag w HF and LP 4;5 Distance above  2.0000

Sag Curves Crest & Sag w HP and LP é;g 1" Graph view top  -1.0000"

Fl m F

Import label set. .. | | Save label set... |

QK ] | Cancel | | Apply | | Help |
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Profile View Styles
e  Controls Visibility of Profile View components

A Profile View Properties - Spaniel Dr.1

|Inﬂ)rmah’on H|Stah'ons mEevaﬁons H|Proﬁ|es ‘ Bands ]Hahd'1 "

— Grid
— Title Band type: Select band style:

| roeons <) g4 be -ERE
—  Axes and Axis Labels it ot s :

Location:

[Bottom of profile view

Profile Label Bands

®  Rows of data/information about the Profiles in a Profile
View
—  Profile Information - Stations, Elevations, etc.
— Vertical Geometry
—  Horizontal Geometry
—  Superelevation Information
—  Sectional Information (covered later)
— Pipe Network Information (covered later)

e  Shown at the bottom or top of a Profile View

e Applied through the Profile View Creation dialog or the
Profile View Properties dialog.

Band Type Style
Profile Data [Land Destg{Dizplays ... [0.0000
Profile Data |Land DegtgDisplays t...J0.5000"
Profile Data [Land DegtgDisplays t..|0.0000"

Major Int... Minor Int... Geometr... LabelSta... Label En... Alignment Profilel Profi

Description Gap
100.00' 25.00'
100.00' 25.00°
100.00' 25,00

Spaniel Dr. |[Existing T...|Existi
Spaniel Dr. [Existing T...|Existi
Spaniel Dr. |[Existing T...|Existi

<J[=][<]
<|[=][%]
<J[=][=]

4|

Match major/minor increments to vertical grid intervals Import band set... ] [ Save as band set... ]

Profile Band Styles

e  Controls individual elements in Band (Boundaries, Text,
etc..)

e  Control display properties of Band Elements
—  Text Style, Orientation
— Label visibility
— Boundary Linetype, Lineweight
— Content and layout of text
— Text height, color, justification
— Create one for each Band type/setup you need
— Civil 3D templates contain pre-made styles

Profile Band Sets

e  Allows multiple Bands to be assigned to Profile Views easily
e Can save and import Band Sets into Profile View Properties
e  Civil 3D template contains pre-made Band Sets
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EXERCISE NOTES

Continue in ‘Road Design.dwg”
Turn off the C-ANNO layer

Change the Style of SPANIEL DR. PROFILE

a. Select the Profile View and open the Properties Palette

b.  Change the “Style” to “Profile View”. Review the changes in the drawing

c. Change the “Style” to “Land Desktop Profile View”. Review the changes in the drawing

4. Apply Band Set to the Profile View
a. Right-click on Profile View and choose “Profile View Properties”
In the “Bands” tab, hit “Import Band Set..”
Choose “Cut and Fill” and hit OK
Change “Profile1” for both of the Bands to “Existing Topo—(Surface)”
Change “Profile2” for both of the Bands to “SPANIEL DR. FG”
Change the “Location” (top left) to “Top of Profile View”
Change the “Profile2” for this band to “SPANIEL DR. FG”
Hit OK

5. Apply a different Band Set to the Profile View
a. Right-click on Profile View and choose “Profile View Properties”
In the “Bands” tab, hit “Import Band Set..”
Choose “EG-FG Elevations and Stations” and hit OK
Change the “Gap” for the remaining band to 0.25”
Change “Profile1” to “Existing Topo—(Surface)”
Change “Profile2” to “SPANIEL DR. FG”
At the bottom left corner, uncheck “Match major/minor increments to vertical grid intervals
Change the major interval to 50’ and the minor interval to 25’
Hit OK

S@a~0oo00T

~Ta@™moeoo00T

6. Save the Drawing
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Corridors

Tt Home wInsert Annotate Modify Analyze View Manage Output Survey  Autodesk360 Help Raster Tools  Express Tools o= -

%@ mm M Import Survey Data &) Parcel -

T Feature Line -

! < Paints ~
' v Surfaces -

Palettes « Create Ground Data «

Assemblies
e  Similar to Civil Design “Templates”
e  Used as base-line for generating cross-sectional definition of corridors
e  Used to manage collection of Subassemblies
e  ‘Home’ Tab> ‘Create Design’ Panel> ‘Assembly’> ‘Create Assembly’
—  Provide a name
—  Select Style
—  Select Code Set

—  Select location for Assembly baseline

Subassemblies
e  Used as basic building blocks of the cross-sectional definition of corridors
e  Standard collection of Subassemblies can be found in the Catalog

— ’Modify’ Tab> ‘Design’ Panel> Subassembly Icon (next to ‘Assembly’)
‘Subassembly’ Tab> ‘Launch Pad’ Panel> ‘Catalog’

e  Often-used Subassemblies easily transferred to Tool Palette for quick access

—  ‘Home’ Tab> ‘Palettes’ Panel> ‘Tool Palettes’ Icon
e  Subassemblies attached to the Assembly base point to created cross-sectional definition
e  Can create custom Subassemblies
e  To Attach Subassemblies

—  Select Subassembly from Catalog and transfer to Tool Palette

—  Click on Subassembly in Tool Palette

—  Set properties and click on attachment point in Assembly

—  Attach Subassemblies to each other through Codes
e  Build each half of Assembly separately by selecting the “Side” property appropriately
e  Use intelligent Copy to, Move to, and Mirror commands

—  Select Subassemblies, then Right-click and choose command

- f" o I-E+ Move O Rotate -~ Trim -
-0 - =~ .a Copy ‘|L Mirror /. Fillet ~ ndl¥
if- & - W - R Stretch gJ Scale gF Amay - JL  Prop
Draw = Modify -

A Create Assembly ! D e S
Marme:
24.ane with C&G
Description:
o

Assembly Type:
[Undiuided Crowned Road

BasicLane

Aszembly style:
Sam Basic
Code set style:
L3 All Codes

BasicLaneTransition

., GenericPavementStructure

ShapeTrapezoidal
Aszembly layer:
C-ROAD-ASSM

houlder

BasicCurb

Ok | [ Cancel

BasicCurb&

BasicSide!

BasicBarrier

Simple




Continue in ‘Road Design.dwg”

Create a typical road section design using an Assembly
a.

poow

“Home” Ribbon tab > "Create Design” Panel> “Assembly”> “Create
Assembly”

Name: 2-Lane with C&G and SW

Assembly Type: Undivided Crowned Road

Leave the other defaults and hit “OK”

Click any empty spot in the drawing to place the Assembly

Open the Tool Palettes

Add a Lane Subassembly

g = = ol Aokl Maees o'W raalREr e edcE . 1

N

a. Onthe “Lanes” tab of the Tool Palette, choose
“LaneSuperelevationAOR”

b.  Width: 12

c. Default Slope 2%

d. Inthe drawing, click on the center attachment point on the Right

Add a Curb & Gutter

a. On the “Curbs” tab of the Tool Palette, choose
“UrbanCurbGutterGeneral”

b.  Subbase Extension: 0.00°

c. Dimension B: 127

d. Dimension D: 6”

e. Dimension E: 7

f.  Dimension F: 6”

g. Attach to Top Edge of Pavement on the Right

Add a Sidewalk

a. Onthe “Curbs” tab of the Tool Palette, choose “UrbanSidewalk”

b.  Sidewalk Width: 5

c. Outside Boulevard Width: 3

d. Attach to top Back of Curb on the Right

Add Daylight

a. On the “Basic” tab, choose “BasicSideSlopeCutDitch”

b.  Cut Slope: 31

c. Fill Slope: 4:1

d. Attach to right edge of grass strip/boulevard

Mirror to complete symmetrical Assembly

a. Close the Tool Palettes

b.  Select each of the subassemblies on the right side until all are selected

c. Right-click and choose “Mirror”

d. Choose main center attachment point as mirror Marker

Save the drawing

Mo selection

Information
Description
Show Tooltips
General
True Color Bylayer
0
Bylayer

Lineweight Bylayer
Data

Default Loop In Layo... Last

Default Loop Off 10,0000

Geometry Generate

.NET Class Name Subassembly.LaneSupere...

ADVANCED -
Parameters -

Default Slope

Sub-base Depth

.
-
-
L]
.
L
L
L
.
L
L
L
.

Width 2,000 :
L
.
L
L]
L
.
L
-
L
.

L4

Ve SPTIYIPl wn M unnnunnnnsn

* Specific Subassembly
Properties
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Corridors

CONCEPT

» Inset  Annotate

| Modify  Analyze
m M Import Survey Data

ﬂ Parcel ~
F f¥ Surfaces -

Palettes

& Grading -

Create Ground Data +

Corridor Definition

- Alignment » =

View Manage Output

R ! Feature Lingw= = Profele ==,

% Corridor 3

Raster Tools
- @ -
- &

Draw =

Survey  Autodesk360  Help

o " Profile View ~
4 Assembly ~ —3 Sample Lines
31 Pipe Network ~ g% Section Views -

Profile & Section Views

Used to create a 3D model of anything that has a horizontal, vertical, and cross-sectional definition

— Highways and Roads

— Railroads

—  Ditches

—  Culverts

—  Etc.

Corridor requires 3 pieces of information to build

—  Horizontal Alignment

—  Profile (Usually Design Profile/Vertical Alignment)
- ***OR**** Feature Line

—  Assembly (Cross-section)

Create Corridor

‘Home’ Tab> ‘Create Design’ Panel> ‘Corridor’

—  Corridor based on single alignment and profile
Provide a name and description

Select Alignment (or press enter for dialog)

Select Profile (or press enter for dialog)

Select Assembly (or press enter for dialog)

Quick Notes

As of Civil 3D 2017, a Feature Line can be used
to create a Corridor in place of the Alignment/
Profile combination

Logical Name Mapping used to set target alignments, profiles, or surfaces.

Express Tools L

il () Rotate

o - " Copy  dh Mirror

= - R stretch Fl Scale g8 Amay
Modify «

'I-E-I Move - Trim

Al Fillet

Mame:
SPAMIEL DR.. MODEL

Description:

Corridor style:
E‘E Basic
Corridor layer:

C-ROAD-CORR

Baseline type:
@ Alignment and profile

(71 Feature line
Alignment:

“~3 SPANIELDR.

- &
— &

Profile:

Aszembly:
&, 2-Lane with C&G and SW

;'

Target Surface:
@ Buisting Topo

- [y

Set baseling and region parameters

J | | |

Cancel

| [

Help




1. Continue in ‘Road Design.dwg”
2. Create corridor model from Spaniel Dr.

a. “Home” Ribbon tab > "Create Design” Panel> “Corridor”
b. Name: SPANIEL DR. MODEL

c. Alignment: Spaniel Dr.

d. Profile: Spaniel Dr. FG

e. Assembly: 2-Lane with C&G and SW
f.  Target Mapping Surface: Existing Topo

g. “Set baseline and region parameters”  Unchecked

h.  HitOK

3. View Corridor in the Object Viewer
a. Zoom/Pan back to the Plan view of the site
b.  Select the model, then right-click and choose “Object Viewer”

c. Use the left mouse button to click and drag and rotate the
model

d. Zoom in to a small area and set the “Visual Style” (top left of
the window) to “Realistic”. Examine the results

e. Change the Visual Style to “Shaded with Edges”
Close the Object Viewer
5. Save the Drawing
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reate Sample Lines
.

. :

Properties 7 12 Rebuild Corridor - » i’™ Split Region % Match Parameters " 1l Add a Section

% Object Viewen < —
L]

0

2 Corridor Surfaces VY Add Regions 2% Merge Regions S Feature Lines from Corridor
Corridor Section

B Lsolate Objecd  Properties ~ Add Baseline Targets |3 Edit Frequency Vi Copy Region Editor ~

ﬂ'y_ Delete a Section = __ 2 S _ _ .
. Sight Distance Drive Extract Corridor Solids ~ Superelevation
= ‘. Alignment from Corridor

4usnnmnnn?®

.
General Tools =
dapsnnnnnn

a
=g
3

Analyze Corridor Tools Launch Pad ~

Change Base Objects
e Any change to objects in definition will be detected by Corridor and will automatically update (if setting is selected)
—  Edit Alignment
—  Edit Profile
—  Edit Assembly
®  Can set to “Rebuild - Automatic” from the Prospector

TOOLSPACE

T

Master View -

Change Definition

yspect

- Open Drawings
=-[™ Corridors - Corridor Surfaces - Finished

®  Done in “Corridor Properties” dialog

Pre

—  ‘Corridor’ Tab> ‘Modify’ Panel> ‘Corridor Properties’ :@; Points
— Right-click on Corridor name in Prospector and choose “Properties” ~[#] Point Groups
—  Right-click on Corridor in drawing and choose “Corridor Properties” -~ Point Clouds

B @ Surfaces
B "7F Alignments

@ Sites

@ Catchments

e  Change which objects are used in creation
e  Add Additional Baselines (CL Alignments)
®  Add Regions along Baselines

— Right-click on Baseline and hit “Add Region” &7 Pipe Networks
—  Use different Assemblies along one Baseline - 3] Pressure Networks
—  Assign different Alignments and/or Profiles to Assembly along Baseline -y Corridors

i -
e Change sampling frequency Spaniel Dr. Model

. . . - A b Properties...
(@)) — Interval along lines, curves where the Assembly is applied _‘% gk : -
+ Interseci Corridor Section Editor...
C . Py . Sl
— Edit Individual Sections B 5% Survey —
— e  Override settings at individual Sections or Section ranges - [E] View Fra

Rebuild - Automatic
—  Change Subassembly settings, values, and targets. II—II|E| Data Shortcuts —

F_% Surfaces Drive

= Alignments Select

m Pipe Metwo. Fanrnis
m Pressure Ne

Ed

— Add additional Assemblies and Subassemblies

—  View Sections without generating Section Views

e  Three ways to access this functionality

—  ‘Corridor’ Tab> ‘Modify’ Panel> ‘Corridor Section Editor’ [@‘1 i Erria failn B
—  Right-click on Corridor name in Prospector and choose “View/Edit Corridor Sections” ) [l Drawing Ternpl Export LandXML...
— Right-click on Corridor in drawing and choose “View/Edit Corridor Sections” Refresh

Corridors




EXERCISE NOTES

1. Continue in ‘Road Design.dwg”

2. Set the Corridor to Automatically Update
a. Prospector > expand “Corridors” > right-click on “SPANIEL DR. MODEL” and choose “Rebuild- Automatic”

3. Edit Assembly
a. Zoom to the Assembly, select the right lane, right-click, and choose “Subassembly Properties”
b. Change the “Width” to 10’
c. Repeat steps a. and b. to change the width of the left lane

4. Change the Frequency

a. Select the model in the plan view and from the context tab, choose “Edit Frequency”

b.  Move the cursor over the Corridor until a blue outline appears and left-click to select that region
c. Along Curves : “By curvature”

d. Mid-ordinate distance to define...” 0.1

e. Along Vertical Curves: 10

f

. Hit “OK” again to rebuild the corridor

5. Open and Configure the Section Editor

a.  With the Corridor still selected, choose “Section Editor” from the context tab __
b.  From the Section Editor, choose “"Viewport Configuration” 2
c. Viewport 1: Section &
d. Viewport 2: Plan

e. Viewport 3: Profile

f Hit OK o ——

6. Change the Fill Slope on the left side of the road near the pond

a. Use station slider to advance to Station 2+75 and click on “Parameter Editor”
b. Expand “Left” > expand “BasicSideSlopeDitch™, locate “Fill Slope” —|
c. Inthe “Value” column 2:1 and hit <TAB>. Notice the change in the Plan View | —
d. Inthe Station Editor tab, hit “Apply to a Station Range”
e. Leave the “Start Station” at 2+75, and for “End Station”, enter 4+50 |
f. HitOK |
g. Inthe Station Editor, hit “Update Corridor” I—"
h. Look at Plan View to see the change li
7. Close the Section Editor =]

Save the Drawing
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Select a Baseline: Select a Station:
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Editor Ass.embllry 131 Add a Region «  Tracker Extents = B Display Objects
(T C1]

4smmmEmmnnn EEsmmmn?®

General Baselines & Offsets Station Selection s Analyze View Tools Close




7))
(b
O
©
Y
| -
-
7))

Corridors

Corridor Surfaces

Home Insert Annotate Modify Analyze View Manage Output Survey  Autodesk360 Help  Raster Tools  Express Tool® C or: Spaniel Dr. Model ® &~

B Properties 1 G r C » im SplitRegion & Match Parameters 1% #& AddaSection Q o= ° § Create Sample Lines
1 ) | 3

~ | . o
ﬂ_ Object Viewer Corridor™ &y Corridor Surfaces : Edit I-'i‘ Add Regions 2} Merge Regions Sl:cﬁ:n & Delete a Section ‘ig-j Feature Lines from Corridor
Sy Isolate Objects  Properties? = | AddvBuschimes = = a¥ Targets |3} Edit Frequency V72 Copy Region Editor ~
GeneralTools v |~ ModifyComidor~ |~ ModifyRe | ModiyComndorSections | Analyze | ComdorTools |~~~ launchPad v

Sight Distance Drive Extract Corridor Solids  Superelevation

. Alignment from Corridor

Create a Surface from the Corridor

—  ‘Corridor’ Tab> ‘Modify Corridor’ Panel> ‘Corridor Surfaces
—  Surface Created from Links and Codes (Top, Datum, etc...)
—  Set Surface style (same as regular surface styles)

—  Can add boundaries (Outer, Hide, Render Only) from Corridor Properties dialog - “Boundaries” Tab to define
surface extents

e  Boundary can be defined automatically from various corridor components such as the corridor extents
(Daylight), which essentially “shrink-wraps” the surface.

—  Perform Volume comparisons
New Surface automatically created in Prospector
To create final proposed surfaces

—  Paste Proposed Surface into copy of Existing Surface

Quick Notes

®  Creation of the Corridor Surface is vital for volume
comparisons because you can’t compare a corridor
model to an existing Surface. You must compare a
Surface to a Surface to get Volume calculations.

e  Datum Surfaces can look strange if the Assembly
contains any overhang (Example: Curb and Gutter
that has subbase extending past the back of curb.)
The way to fix these Surfaces is to set the “Overhang
Correction” in the Corridor Surfaces dialog to “Bottom
only”



EXERCISE NOTES

1. Continue in ‘Road Design.dwg”

2. Create FG Top Surface
a. Select the Corridor and choose “Corridor Surfaces” from the context tab. |_
2

b. Create a new Surface using the new Surface button, and rename it to “SPANIEL DR. FG”

c.  With the new Surface selected, set “Specify Code” to “Top” and hit the + button. [

d. Set the Surface Style to “Contours 1’ and 5 (Design)” |i|

e.  Switch to the “Boundaries” tab, select the “SPANIEL DR. FG” Surface, right click, and choose “Corridor extents as
boundary”

f. HitOK

3. Create Corridor Datum Surface

a. Repeat #2 above using the following parameters to create a new Corridor Surface for the Datum
b. Name: SPANIEL DR. DATUM
c. Specify Code: Datum
d. Style: Border Only
e. Overhang Correction:  Bottom Links
f.  Add Boundary: Corridor Extents as Outer Boundary
g. Back on the “Surfaces” tab, under “Overhang Correction” for the new Datum Surface, choose “’Bottom Links”
h. Hit OK
A Corridor Surfaces - SPANIEL DR, MODEL e e
Surfaces ]Boundaries ]
Add data
Data type: Specify code:
w) ® K R ks - 1o ) B (%]
MName Surface Style Render Material Add as Breakli... Owerhang Cor... Description
' = (m” SPANIEL DR, FG Contours 2' and 10' (Design) (7 ByLayer & Mone
CLET Top O
S SPANIEL DR. DATUM  Berder Only £y ByLayer @ Mone
¥ Datum Fl
4 i 3
OF; ] | Cancel | | Apply | | Help
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Modify  Analyze

mm ! Import Survey Data
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View  Manage

Output  Survey  Autodesk 360  Help

Alignment - Intersections ~

Raster Tools

e

Express Tools
+E+ Move

Q- w- % Copy

- &~ :Ii,ft- aStretch

Draw «

4 Assembly ~
T1 Pipe Network ~ "."Sﬂ!ﬂdﬂ“ﬂuﬂ" i
Profile & Section Views

:_,.T Feature Line = ks Profile =

fr Surfaces ~ & Grading ~ M Corridor

Palettes - Create Ground Data = Create Design =

Cross Section Concepts
®  Cross Sections reside in Cross Section Views
—  Separate Objects

Narne:

A Gt srpe oo

Sample line style:

Spaniel Dr. Sampling

_" Road Sample Line

- [ =

Description: Sample line label style:
—  Cross Sections and Cross Section Views each have Styles " _@%é"gedim T -
Sections must be sampled in order to be created S e
Section (Sample) Lines are organized into Groups et C-ROAD-SAMP
Spaniel Dr.

Create Sample Lines

i Select data to :
e Homel Sample Lines e

. Type Data Source Sample Style Section layer Update Mode
—  Select Alignment
i Existing Topo Finished Ground ~ C-ROAD-SCTM Dynamic

—  Provide Name Spaniel Dr. Model Basic C-ROAD-CORR-... Dynamic

_ Set Sample Line Style and Label Style Spaniel Dr. Model Spaniel Dr. FG O Finished Ground ~ C-ROAD-SCTM Dynamic
@ . Spaniel Dr. Model Spaniel Dr. Datum |:| Finished Ground  C-ROAD-SCTM Dynamic
(- —  Choose Surface(s) and Profile(s) to Sample

— e Use Tools in Toolbar to Create Sample Lines
— By Station
—  Pick Points on Screen
[ ok || caneal |[ e |

—  Pick Existing Polyline
— By Station Range

—  From Corridor Stations
Set Sample Width

Sampl

Sample Line Tools
_;[Sample Line Station Value] > '-E‘ 4:'[% | [_")] Spaniel Dr. S:
Current method: By stations

- Bl KE 5B
Alignment name: 5p }f\( By range of stations...
))=< v At a Station

Lﬁ From corridor stations

L Pick points on screen
o,

=f;  Select existing polylines

Cross Sections




EXERCISE NOTES

1. Continue in ‘Road Design.dwg”
2. Create Sample Line Group

b
c. Forthe name, enter “SPANIEL DR. SAMPLES”
d

“Existing Topo” and “SPANIEL DR. MODEL” checked.
e. HitOK

3. Create Sample Lines

a.
b. Choose “By Range of Stations”

c. Left and Right Swath Width set to 50’
d. Increment Along Tangents: 50’

e. Increment Along Curves: 25

f. At Range Start: True
g. AtRange End: True
h. HitOK

i.

Hit <ENTER> to end the command
4. Save the Drawing

In the Sample Line Tools toolbar, select the “Sample Line Creation Methods” button

a. “Home” Ribbon tab > “Profile and Section Views” Panel > “Sample Lines”
Hit <ENTER> to display the list of Alignments, choose SPANIEL DR. and hit “OK”

A

Under “Select data sources to sample:”, deselect the two Corridor surfaces at the bottom of the list and leave on the

A Create Sample Lines - By Station Range I&J
Property Value
= General
Alignment Spaniel Dr.
= Station Range
From alignment start True
Start Station 0+00.00
To alignment end True
End Station 12+04.82
E Left Swath Width
Snap to an alignment False
Alignment Spaniel Dr.
Width 50.00°
E Right Swath Width
Snap to an alignment False
Alignment Spaniel Dr.
Width 50.00°
= Sampling Increments
Use Sampling Increments True
Increment Along Tangents 25,00
Increment Along Curves 25,00
Increment Along Spirals 2500
= Additional Sample Controls
At Range Start True
At | ' i True
At Horizontal Geometry Points False
At Superelevation Critical Stations  False
OK ] | Cancel | | Help
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fﬂ Create Multiple Views

Palettes + Create Ground Data Create Design ~

-
ﬂ'l'MﬂlIr Create Section View h_‘

Section Views ﬁ Project Objects To Multiple Section Vie

e  Cross Sections reside in Cross Section Views
—  Separate Objects W
—  Cross Sections and Cross Section Views each have Styles

e  Section (Sample) Lines are organized into Groups

Create Section View

e All Cross Sections are displayed in Cross Section Views

e  Wizard walks through necessary steps

7
=
o

e  Can Create Multiple Views as well P General Select alignment: Sample line group name:
T i - [ i i -
: e Select Alignment, Sample Line Group, Sample Line(s), Style, ot S (Sl D [0] Spanel Dr. Samping
> Band Set, and Sections to draw. Station range
Offset Range Start: End:

c © Automatic 0+00.00 12:04.82

o Elevation Range
— (©) User specified: [0+00.00° 115 [12t0482 INER

o Section Display Options 113 | J R

GJ Data Bands =l

. S Section view name:
CD Quick Note SE—— <[Section View Station]>
Like Profiles, Sections cannot be displayed in the el
o drawing without a Section View Desciiption:

Section view layer:

CROADSCTNEW

Section view style:

:/_“é‘F{oad Section b4 ﬂ

<Bac-k. [ MNext = “ Create Section Views |[ Cancel H Help
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EXERCISE NOTES

1. Continue in ‘Road Design.dwg”

2. Create Single Section View
a. “Home” Ribbon tab > “Profile and Section Views” Panel > “Section Views” > “Create Section View”
b.  Make sure the Alignment is set to “SPANIEL DR.”
c. From the “Station” drop-down, choose 0+50
d. Leave the other defaults and hit “Next > “
e. For “Offset Range”, leave the defaults and hit “Next > “
f.  For “Elevation Range”, leave the defaults and hit “Next > “
g. On the “Section Display Options” page, make sure the Style for Existing Topo is set to “Existing Ground”
h. Also, make sure that the Label Set for both is setto “_No Labels”
i. Hit “Next > “
j- On the next page, hit “Create Section View”
k.  Select a location in the drawing for the lower left corner of the Section View.

3. Turn the C-ANNO layer back on
4. Set the Annotation Scale in Model Space to 1" = 20’
5. Create Multiple Views

a. “Home” Ribbon tab> “Profile & Section Views” Panel > “Section Views" > “Create Multiple Views”

b.  Make sure the Alignment is set to “SPANIEL DR.”

c. For the Station Range, select “User specified”, enter 1+00 for the start station and leave the default for the end station

d. Hit“Next>*“ E'

e. For Placement Options, select “Production” and hit the browse button

f.  Leave default for template file name and choose the “ARCH D Section 20 Scale” layout, then hit OK

g. Hit“Next>*

h.  For “Offset Range”, leave the defaults and hit “Next > “

i. For “Elevation Range”, click on “User Specified” and enter 30’ for the height.

j-  Select “Follow a Section”, choose “SPANIEL DR. MODEL” from the drop-down, and hit “Next > “

k.  On the “Section Display Options” page, make sure the Style for Existing Topo is set to “Existing Ground”

l. Also, make sure that the Label Set for both is set to “_No Labels”

m. Hit “Next > “

n.  On the next page, hit “Create Section View”

0. Select a location in the drawing for the lower left

corner of the Section View Group.
160 160
6. Save and close the Drawing
150+ +150
1404 T140
130+ S———— i 130
120 120
10 10
100 100
-50 —40 -30 -20 -10 O 10 2 30 40 50
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Sites

Parcels & Lots

Topology and Organization

Parcels, Alignments, Profiles, and Grading can be organized into Sites
Controls numbering and organization of Parcels and Alignments

Sites represent separate Topology Levels

— Different set of relationships (topology) between objects

Sites are displayed and created in Prospector

Site Concepts and Rules

Each Site has a Site Parcel associated with it that represents the extents of all
objects within the Site.

All objects within a Site are dynamically related to each other.
Objects in one Site are not related to Objects in a different Site.

While parcels within a Site cannot overlap, Sites can overlap, which in turn allows
you to work with overlapping parcels (Ex. property parcels overlapping soil
mapping parcels)

Objects can be moved to a different Site, but the original relationship to the other
objects in the original Site is lost.

Objects within a Site do not have to touch each other.

TOOLSPACE

Active Drawing View

=Y Parcels - Create Parcels - Finished
EI'#‘ Points
[‘5’] Point Groups
@ Point Clouds
@ Surfaces
--"::} Alignments
EI@ Sites
- B FG Grading
EI@ Subdivision Project
: --"::3 Alignments
J Feature Lines
[@] Grading Groups
_ %ﬂ Parcels
EI@ Survey Site
-- "% Alignments
EIJ Feature Lines
[&] Grading Groups
%ﬂ Parcels
@E Catchments
]ﬂlﬂ Pipe Metworks
m Pressure Metworks

Corridors

1 | 1] [

=1

Prospector

ttings

S5e




Open “..\Parcels\Road Design—Create Parcels.dwg”

2. Create Subdivision Site
a. Prospector > right-click on “Sites” and choose “New:
b. Name: Subdivision Lots
c.  On the “Numbering” tab, set the Value for both counters to 101

3. Create Grading Site
a. Prospector > right-click on “Sites” and choose “New:
b. Name: FG Grading
c.  On the “Numbering” tab, set the Value for both counters to 1

4. Create Utilities Site
a. Prospector > right-click on “Sites” and choose “New:
b. Name: Utilities
c.  On the “Numbering” tab, set the Value for both counters to 10001

5. Save the Drawing

A Site Properties - Subdivision Lots l e _S;hl
|Information |30 Genmetry. Mumbering
Property Walue
= Parcels
Parcel: Mext Automatic Area Counter 101
Parcel: Mext Manual Area Counter 101
Fi T 3
OK l | Cancel | | Apply | | Help
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Create Parcels Inset  Annotate  Modfy,. Anabge,, View Manage Output Survey Autodesk360  Helg
e  From Objects .
e Create ROW

e  Parcel Layout Tools

| Import Survey Datas Parcel 7k .

i8] i
s ¥ -----‘
HE < Points ~ ‘w Parcel Creation Tools

I r Surfaces ~
—  Automatic, Semi-automatic or Manual Creation B Fe &

- - &
Palettes = Create Ground Data ~ "—ﬂ‘ Create Parcel from Objects | Profile & Section

—  Specify Default Area and Minimum Frontage

—  Fixed Lines and Curves .
ﬁ i Create Right of Way

—  Slide Angle
—  Slide Direction
—  Swing Line A‘ Create Parcels - From objects l 2 |
— Free Form i
Site:
e  Specify Site, Styles, Layers, and Label Styles SR T o o
pectly y y y @ Subdivigion Lots -
Object |nte||igence Parce! Layout Tools : . : M Parcel style:
= Ej - e it = . A 3 R
e  Labels can be created on the fly qY | e ndla | S~ -x & | & B | K = | &l @Pl‘ﬂﬂﬁ’f‘f hd @ > @]
e  Layers created on the fly ik | Vae Layers
E Parcel Sizing
Minimum Area 10000.00 5q. Rt Par::el Iayer
Minimum Frortage 60.00° 1 .
Use Minimum Frontage At Offset Yes C-PRDP
[ Frortags Offeet 1200 Parcel segment layer:
, t Minimum Wicth 50.00 i g e :
Minimum Degth 5000 C-PROP-LINE
Use Maxdmum Depth Yes
Maximum Depth S00.00°
1| Muttiple Solution Preference Use smallest area Label styles
El Atomatic Layout Area Iabel stgfle
Automatic Mode On
Remainder Distribution Redistribute remainder 6"’ Name Area & Perimet  « K @]

Line segment label style:
@I_-}EJI Bearing over Distanc: - @|‘ Q,

c
O

Curve segment label skyle:
@]’5 Delta over Length an @ |" q

Creat

[7] Automatically add segment labels

% Select a command from the layout tools 4 Erase existing entities
b
&)
— R [ oK ] [ Cancel ] [ Help ]
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1. Continue in “Road Design—Create Parcels.dwg”
2. Create Western Parcel from Objects

a. “Home” Ribbon tab > “Create Design” Panel > “Parcel” > “Create Parcel from Objects”

b.  Choose all three of the polylines that make up the parcel on the western side of the road and hit <ENTER>
c. Site: Subdivision Lots

d. Parcel Style: Property

e. Area Label Style: Name Area & Perimeter

f.  Automatically Add Segment Labels: Unchecked

g. Erase Existing Entities: Checked

h.  Hit OK

3. Repeat the steps listed in #2 above to create a Parcel from the polylines on the east side of the road.

Subdivide Parcel 101 (Western side of the road) o
a. “Home” Ribbon tab > “Create Design” Panel > “Parcel” > “Parcel Creation Tools” o

b. Inthe Parcel Layout Tools toolbar, choose the double arrow on the right side to expand the toolbar and set the
following parameters:

Minimum Area: 10,000 sq. ft.
I Minimum Frontage: 75 ft.
I Multiple Solution Preference: Use Smallest Area
I Automatic Mode: On
I Remainder Distribution: Redistribute Remainder

c. From the toolbar, select the “Slide Line Create” Tool

d. Inthe dialog that appears, set the following options: @
I Parcel Style: Single-Fa "
I Area Label Style: Name Area & Perimeter
I Automatically Add Segment Labels: Checked

a. Select Parcel 101 (by selecting the label)

Use and Endpoint OSNAP to choose SE corner of Parcel 101 as
frontage start point

Use and Endpoint OSNAP to choose NE corner for frontage end point
For the angle, enter 90 and hit <ENTER>
To accept the results, hit <ENTER> again.

Hit <ESC> to end the command and close the Parcel/ Layout Tools
toolbar

=

~0 oo

5. Save the Drawing
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Horne
Add = Add _Renumber
Labels Tables Tags

Labels & Tables

Annotate
B Properties
% Object Viewer
8y Isolate Objects

Insert Modify  Analyze View  Manage

Edit

Properties i

General Tools +

<%, Edit Area Label Style

Parcel Grip Editing
e  Shift Entities
e  Grip placement depends on method of Parcel creation

®  Move, Drag, Flip, Reverse Labels

Parcel Segment Editing

e  Select Modify Tab> Design Panel> Parcel Tools or
e  Select the Parcel on screen to activate Parcel Tab on the Ribbon
Insert/Delete PI

Break, Trim, Join, Reverse

Parcel Union/Dissolve Union

Delete Sub-entity

Sub-entity Edit

—> Edit one Sub-entity at a time

—> Values in Black can be edited

—> Values in Grey are fixed

Parcel Offset

Renumber Parcels (covered in Level I1)

S8 Multiple Parcel Properties

Geometry Elevatio

Output Survey Help Raster Tools Express Tools "'Geolocation  Parcel: Single-Farmily : 5

rading Creation Tools
k4 Quick Profile

: Renumber/Rename
Edit Create

Parcel Layout Tools Points

Launch Pad

Modify

Parcel Elevation Editing

e  Assign Elevations to Parcel Segments
—  Tabular Elevation Editor (discussed later in “Grading”)

(] Insert, Delete Elevation and High/Low Points

®  Get Elevations from Surface

Object Intelligence
e  All adjacent parcels update automatically
o  All labels update automatically

®  Any tables (covered later) update automatically

Quick Note

Never use AutoCAD ERASE to delete Parcels or Parcel
Segments. Doing so can result in drawing corruption.




1. Continue in “Road Design—Create Parcels.dwg”

2. Girip Edit Parcels
a. Select the Parcel Segment between Parcel 109 and 110 to display the grip
b.  Select the grip and drag it slightly North. Notice that the Segment maintains the 90° angle to the frontage line.
c. Click again to place the line in the new location. Notice that the Area Labels for the two Parcels as well as the
Segment Labels are automatically updated.
d. Hit <ESC> to deselect the line

3. Offset Parcels to build BRLs
a. Initiate the AutoCAD Offset command
b. Use 15’ as the offset distance
c. Select the Area Label for Parcel 108 and then pick a point inside the same parcel

4. Perform Parcel Unions
a. “Modify” Ribbon tab > “Design” Panel >“Parcel” > “Modify” context tab > “Parcel Layout Tools”
b. Inthe Parcel Layout Tools toolbar, choose the “Parcel Union” button. Q_—| -
c. For the destination Parcel, choose the Areal Label of Parcel 110.
d. For the Parcels to union, select Parcel 109 and hit <ENTER>. Notice that the Parcel Segment is still in place but the
Area Label for Parcel 110 now shows the total area for both.
e. Click on Parcel 110 and notice that the area highlighted surrounds both of the original Parcels
f.  Click on the down-arrow in the Parcel Union button and choose “Dissolve Parcel Union”.
g. Select Parcel 110 and the Parcels will separate again (new numbers, default styles)

5. Delete Sub Entities
a.  With the Parcel Layout Tools toolbar still [
open, select the “Delete Sub-Entity” o o 00 oo
button = st
b. Select the Parcel Segment that sepat =3¢
Parcels 111 and 112. Notice that the
Parcel Segment is completely removed

257

.57

__20.54"

T NE g
. st o0 oo

SINGLE=FAMILY = 110

\ [
and only one Parcel remains. | _ AR R %2 :
| Perimeter; 516,37 'JUI |

6. Close the Parcel Layout Tools toolbar

7. Save the Drawing

SH'-\GLE—%%I-.HLY : 109
Area: 0.33 AC
Perimeter: 513.64°

o
P _“ﬁ?ﬁ
afgo®

SINGLE—-FAMILY : 108
Area: Q.24 AC
Perimeter: 456,79
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Networks

Fipe label stﬁe

é,:'lgF‘Ian Length Descriptiona « E [@]

—  Add Part Families for Pipes and Structures

—  Pipe Part Families can be made up of circular, elliptical, rectangular, or egg-shaped pipes

F B & Surfaces - & Grading ~ M Corridor § s E’r.p.r:.h:'e.ftu.o:k.:.: fE Section Views ~ y Network name:
Palettes - Create Ground Data « Create Design :_E'i e s e PROP STORM
Pipe Tools in Civil 3D Network description:
q) ®  Pipe networks are comprised of a pipe runs and structure objects
. 9. e Elements
D_ —  Pipe Network Catalog MNetwork parts list:
> —  Parts Lists CADD - Storm Sewer A
= —  Rule Sets [ Layers...
> —  Structures Surface name:
E —  Pipes @ Existing Topo -
(D e  ‘Modify’ Tab> ‘Design’ Panel> ‘Pipe Network’ or Select a Pipe Network on the screen to open ‘Pipe Network’ Tab Alignment name: .
(@)) e  ‘Home’ Tab> ‘Create Design’ Panel> down arrow "> ‘Set Pipe Network Catalog’ "~ SPANIEL DR. h
c —  Select either an imperial or metric Pipe Network Catalog containing the desired pipes and structures to be used Structure label style:
"c_'U' e ‘Pipe Network’ Tab> ‘Network Tools’ Panel> ‘Parts List'> ‘Create Parts List’ NS = @
5

—  Within the Pipe Part Family you can select the pipe diameter and flow coefficients [ ok || cancel || hep |

Structure Part Families can be made up of inlet-outlet or junction structures
—  Within the Structure Part Family you can select the wall thickness, inner diameter, materials, etc.

e  Can create a Pipes Rule Set
—  Specify minimum or maximum pipe cover and slopes
—  Specify minimum or maximum pipe lengths

Pipe Network Creation

e  ‘Home’ Tab> ‘Create Design’ Panel> ‘Pipe Network’> ‘Pipe Network Creation Tools’

Quick Note

—  Opens the Create Pipe Network settings dialog Always check your Upslope/Downslope setting

. before beginning a Pipe Layout
—  Network Layout Toolbar used to layout pipes and structures

Network Layout Tools - Storm Sewer CL - : ;9 %
ﬁ"ﬂ| @|"::3 |l‘f‘.:I ﬁﬁxﬁxﬂ?lnch(:cnm - @24x33|nd1ﬂcnu‘e¢e|/}v |m | | L]
Parts List: Storm Sewer Surface: Existing Topo Alignment: <‘r;c-rr-1v.-e:~ Y

Gravity Pipe Networks




EXERCISE NOTES

1. Open “.\Gravity Pipe Networks\Road Design—Creating Pipe Networks.dwg”

2. Create Sanitary Pipe Network from Object

a. ‘OHl;)me’ Tab> ‘Create Design’ Panel> ‘Pipe Network’> ‘Create Pipe Network from
ject”
b. Choose Magenta SAN polyline that runs along the road
c.  Make sure flow arrow point down-station (North to South)
d. Name: PROP SANITARY
e. PartslList: Sanitary Sewer
. Pipe: 10 Inch PVC
g. Structure: Concrete Structure 48 dia 18 frame 24 cc
h.  Surface: SPANIEL DR. FG
i.  Erase Existing Entity: Checked
j. HitOK
3. Create Storm Pipe Network using Pipe Network Creation Tools
a. “Home” Tab> “Create Design” Panel> “Pipe Network”> “Pipe Network Creation Tools”
b. Name: PROP STORM
c. PartsList: CADD-Storm Sewer
d. Surface: Existing Topo
e. Alignment: SPANIEL DR.
. Structure Labels: <none>
g Pipe Labels: Plan_Length Description and Slope
h. Hit OK

4. Layout the Storm Sewer CL Pipe Network

a. Inthe Network Layout Tools toolbar, click the Upslope/Downslope button until the arrow is pointing down
From the Structures drop-down, choose the 24 X 24” Rectangular Structure
From the Pipes drop-down, choose the 15” Concrete Circular Pipe
Click the “Pipes and Structures” button and place the first structure at the center of Circle A
Follow the chart below to place the rest of the Pipes and Structures:

f
f

2

®ao0o

Structure Pipe Placement

24 X 24" Rectangular Structure 15” Concrete Pipe Center of Circle B

Concentric Struc 48 dia 24 fra
Eccentric Struc 48 dia 24 fra
Concentric Struc 48 dia 24 fra
Concentric Struc 72 dia 24 fra
Concentric Struc 72 dia 24 fra
Concentric Struc 72 dia 24 fra
Concentric Struc 72 dia 24 fra
68 X 6 X 57 Concrete Headwall
24 X 24” Rectangular Structure

18” Concrete Pipe
27" Concrete Pipe
36” Concrete Pipe
36” Concrete Pipe
42” Concrete Pipe
48” Concrete Pipe
48” Concrete Pipe
54” Concrete Pipe
15” Concrete Pipe

Center of Circle C

Center of Circle D

Center of Circle E

Center of Circle F

Center of Circle G

Center of Circle H

Center of Circle |

Center of Circle J, then Hit <ENTER>

Start at Center of Circle K, tie into Inlet @ Circle B

5. Close the Network Layout Tools toolbar and save the drawing

59




Home Elnserl Annotate  Modify Analyze View = Manage =~ Output Survey Help RasterTools Ex A Cre,atehli.g.pment—me Pipe Netw.. (IS
n

I i - Import Survey Data &} Parcel - = Alignment ~ ntersections - hs” Profile View ~ Site:
2 = Site:
I & 2 o ’T ” vA-_--- Eenmnn? 2
E < Points - Feature Line : ignment Creation Tools Pleline @ <None> b [—I—]E)je hd
E £¥ Surfaces ~ [ Grading ~ g on Views ~ Marme:
Palettes « Create Ground Data « : Create Best Fit Alignment ection Views -E)qs-tmg Storm CL
Type:
Create Alignment from Objects R ]
N o
Creating a Pipe Network CL Profile Create Alignment from Corridor BEEEis i
e Must first create an Alignment from Network Parts in order to 2
draw in Profile View. ) ) . Create Alignment from Network Parts -
— Choose each Network Part in the order that the alignment
should be created. : o [TTTTCEE
N . Craate AEanment From Pre o Metwork Start tation: 0-+00.00
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o e  Tabular Editing _ Create Widening Alignment abel set:
e Add Labels 4% _No Labels - [l

I Create profile and profile view

"
)
o

Display Network Parts in Crossing Profiles
Make sure that the desired profile view is already created.

e  Make sure that the pipe network parts you want to display in the profile view have valid station offset data from the 4
alignment they reference.

. ‘Pipe Networks’ Tab > ‘Network Tools’ Panel > ‘Draw Parts in Profile’

. In the drawing, select a pipe network part from the network you wish to add to the profile view, or enter ‘S’ to select certain parts from the pipe network.
. Select a profile view.

e  The pipe network parts are displayed in the profile view. Override the part style in the Profile View Properties to display crossing styles.

o) (o ) [

P

Raster Tools  Express Tools. .
P Quick Note

If you select a specific part in the drawing and then

choose this command from the Context tab, it will

insert only that individual part into the Profile View

Connect Part 1 Split Metwork

Disconnect Part 3¢ Merge Networks
Swap Part 1 i S_mers‘ Sanita

Interference Storm  Editins
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1. Continue in “Road Design—Creating Pipe Networks.dwg”

2. Create Alignment for the Storm Network
a. “Home” Tab> “Create Design” Panel> “Alignment” > “Create Alignment from Network Parts”

b. Select the Headwall in Circle A, then select the Catch Basin in Circle J, and hit <ENTER>
c. Name: PROP STORM CL

d. Alignment Style: Basic

e. Label Set: _No Labels

f. Create Profile and Profile View: Checked

3. Create the Profile and Profile View using the following settings

4. Add the Storm Crossing Pipe to the Road Profile

Sample Existing Topo and SPANIEL DR. FG Surfaces

Set FG Profile sample Style to “Design Profile”

Create Profile View

Use “Land Desktop Profile” Style

Leave defaults for stations and elevations

Set both profile Label Sets to “_No Labels”

Leave default selections for Pipe Network

S@ "0 o0 oo

Use “EG-FG Elevations and Stations” Band set and sent Profile 2
to “SPANIEL DR. FG”

a. Inthe plan view, select the three pipes that cross the SPANIEL DR.

Alignment

b. “Pipe Networks” context tab > “Network Tools” Panel > “Draw Parts

in Profile”

c. Select the Profile View that displays the SPANIEL DR Profiles =

o

Hit <ESC> to deselect the Pipes

e. Select the Profile View again, right-click and choose “Profile View

Properties”

f. On the “Pipe Networks” tab, check the box at the bottom of the

dialog to “Show only crossing pipes”.

g. Highlight all of the Storm Pipes in the remaining list, put a check in

the box under “Style Override”,

and then use the drop-down that .
appears to choose “Pipe

A Profile View Properties - SPANIEL DR.1

(==

Crossing Pipe Storm”

[nformation ||Stations | Eievations |Profies |[Bands ||Hatch | Pipe Networks

h.  Hit OK twice to close both [Name Draw Description

Style Style Override

dialogs and apply the changes. = 3 PROP SANITARY

Single Line (Sanitary) [ ] <Not Overridden>

Single Line (Sanitary) [ ] <Not Overridden>

& Pipe- (1) CNo 10 inch PVC
5. Save and close the drawing o L S

: p
B pipe - (12)

18 inch Concrete Pipe | C-STRM-PROF

Double Line (Storm)

12 Pipe Cro:

A PickPipesyle =)

&2 Doutle Line (Storm)

&2 Basic
3 Doute Line (Sanitary)

&3 Doutle Lne (Storm) 4
62 Pie Crossing Pie (Saniary) =

[] show only parts drawn in profile view
[#] show only crossing pipes

a
- 6§ Single Line (Sanitary) L

&é Single Line (Storm)

ok [ Cancel [ Ay |[ Hep
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Gravity Pipe Networks

Pipe Network Labels
e  Plan Labels can be added during Pipe Network Creation or afterwards

e  Profile Labels must be added after Pipes and Structures have been added to Profile View

®  Annotate’ Tab> ‘Labels & Tables’ Panel> ‘Add Labels’ > ‘Pipe Network’

e Display based on Label Styles

. Label Commands

Entire Network Plan
Entire Network Profile
Entire Network Section
Single Part Plan
Single Part Profile
Single Part Section
Spanning Pipes Plan
Spanning Pipes Profile

Pipe and Structure Labelling in Profile

®  Pipe Network Profile Labels have a “Dimension Anchor” and a “Dimension Anchor Value

e  Dimension Anchor corresponds to “Structure Dimension” location in Label Style

(] Dimension Anchor can be:

Fixed Elevation

Above Structure

Below Structure

Graph View top (Profile View top)

Graph View bottom (Profile View bottom)

e  Dimension Anchor options set in Feature Settings:

‘Settings’ Toolspace Tab> right-click on ‘Pipe Networks’ > ‘Edit Feature Settings’ > 'Default
Profile Label Placement’

e  Dimension Anchor options can also be changed after labels are placed using the Properties Panel

This is necessary when some labels must be placed on top of Structures and others must be
placed below.

Multiline
Text

Parcel

Feature Line

Alignment

% Add/Edit Profile Labels
% Add Intersection Label

) VR AL, m )

Pipe Network L
IIIIP@!ﬂJT‘;NmMIIIIIIIIIIII"

Profile View 4
% Add Projected Object Label
% Add/Edit Sample Line Group Labels
Section View

Line and Curve

% Motes

==

Manage

Road Desig

¥ Add Pipe Network Lapels
% Entire Netwark Plan

% Entire Network Profile

% Entire Network Section
¥ Single Part Plan

¥ Single Part Profile

¥ Single Part Section

% Spanning Pipes Plan

% Spanning Pipes Profile

Property Value Override ~
CiTime
TiDefault Styles
ﬁﬂbehult MName Format
HiDefault Rules
TlPipe Network Defaults
Tistorm Sewers Migration Defaults
B JDefault Profile Label Placement
Dimension Anchor Option for Pipes Fixed
Dimension Anchor Elevation Value for Pipes  0.00'
Dimension Anchor Plot Height Value for Pipes 0.0000"
Dimension Anchor Option for Structures Above ¥
Dimension Anchor Elevation Value for Struct... 0.00"
Dimension Anchor Plot Height Value for Stru... 0.0000"
Structure Label Placement At Middle of Structure
JliDefault Section Label Placement
Ciunitless
| At
< >
Dimension Anchor Option for Structures: EA
Parent Value: N/A
Parent: Current lgz"
E
oK Cancel Apply Help




EXERCISE NOTES

1. Continue in “Road Design—Creating Pipe Networks.dwg”

2. Prepare Structures for Labeling—Change names

a. “Prospector” Toolspace Tab> “Pipe Networks” > “PROP
STORM?” > “Structures”

b. Inthe Item View at the bottom of the Prospector, click in the
first row under “Name”, clear its contents and type “1”

c. Repeat step b. for all Structures, incrementally increasing the
number by 1 each time (see screen shot below):

d. Once complete, use the <Shift> key to highlight all of the rows
Scroll to the right and locate the “Reference Alignment” column

f.  With the rows still highlighted, right-click on the column header
that says “Reference Alignment” and choose “Edit”.

g. From the dialog, choose “Spaniel Dr.” and hit “OK”

3. Establish Default Settings

a. “Settings” Toolspace Tab> right-click on “Pipe Networks” >
“Edit Feature Settings”

b. Expand “Default Profile Label Placement”
c. Set “Dimension Anchor Option for Structures” to “Above”
d. Hit“OK”

4. Add Labels to Entire Network in Profile

a. ‘Annotate’ Ribbon tab > “Labels & Tables” Panel > “Add Labels”
> “Pipe Network” > “Add Pipe Network Labels”

. Change the “Label type” to “Entire Network Profile”
c. Setthe “Pipe Label Style” to “Profile_Length Description and

Slope”
d. Set the “Structure Label Style” to “CADD-Storm Profile Top”
. Hit “Add”
f.  Select any of the Pipes or Structures in Profile to place the
labels

5. Add Labels to Entire Network in Profile

a.  With the “Add Labels” dialog still open, change the “Label type”
to “Single Part Profile”

b.  Set the “Structure Label Style” to “CADD—-Storm Profile Bottom”
c. Hit“Add”

d. Select each Structure, one at a time, to add a second label to
the structures.

e. Close the “Add Labels” dialog

NOTE: These Labels will not be placed in the correct location. This
will be corrected in the steps below

6. Change the Settings for the bottom labels

a. Select all of the Labels that contain Invert information to
activate the grips

Right-click and choose “Properties”

c. Change the “Dimension Anchor Option” to “Graph View
Bottom”

d. Close the Properties Palette

7. Save the drawing
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Pressure Network Tools in Civil 3D
®  Pressure networks are comprised of a pipe runs with bends and valves
e Elements r k

—  Pressure Network Catalog

—  Parts Lists

—  Pipes (DIP)

—  Fittings (Elbows, Tees, Crosses, Reducers, Caps, etc.)

—  Appurtenances (Valves)

e  ‘Modify’ Tab> ‘Design’ Panel drop-down> ‘Pressure Pipe Network’ or Select a Pipe Network on the screen to open
‘Pressure Networks’ Tab

e  “Home’ Tab> ‘Create Design’ Panel> down arrow ’> ‘Set Pressure Network Catalog’

—  Select one of the metric or imperial catalogs in order for the desired pipes, fittings, and appurtenances to be used
®  ‘Pipe Network’ Tab> ‘Network Tools’ Panel> ‘Parts List’> ‘Create Parts List’

—  Add Part Families for Pipes, Fittings, and Appurtenances

—  Pipe Part Families are limited to circular DIP Pipe

—  Within the DIP Pipe Family you can select the pipe diameter and flow coefficients

— Available Fitting Part Families and Appurtenance Part Families vary within each Part Catalog Quick Note
Pressure Pipe Network Creation ';"ggss 3:‘:&';{’33;58;’;; ustetting before beginning
e  ‘Home’ Tab> ‘Create Design’ Panel> ‘Pipe Network’> ‘Pressure Network Creation Tools’

—  Opens the Create Pressure Pipe Network settings dialog

—  ‘Pressure Network Plan Layout’ tab used for Layout

— Angles limited to available bends and pipe deflection (see illustration on the next page)

Home Insert  Annotate M 0 S Help  Raster 2 Hp Pressure Network Plan Layout: Water CL o -

& Existing Topo o and material: ‘,?0 " Break Pipe |E' Panorama *
L%}

ine-10 in-push on- . Add Fitting elbow-10 in-11.25 degree-p =
S pipe-10 in-push on-ductile . ; Pas . Yellow
Pipes & Pipes wdd Appurtenance gate valve-10 inch-pushon «

Properties #& Water Bends Only lide Parts Diameter: 150px

Metwork Settings Layout Insert Modify Compass ~




EXERCISE NOTES

Open “..\Pipe Network\Road Design —Pressure Networks.dwg”
2. Create Pressure Network using Pressure Network Creation Tools

a. “Home” Ribbon tab> “Create Design” Panel> “Pipe Network” > “Pressure Network Creation Tools”
b. Name: PROP WATER
c. Parts List: Water A Create Pressure Pipe Network Li:-?-]
d. Surface: Existing Topo Mt
e. Alignment: SPANIEL DR. e WATER' |ﬁ|
f.  Leave the other defaults and hit OK -y
Network description:
3. Layout Water Network e
a. Inthe “Pressure Network Plan Layout” command tab, set the cover
to 4
b. From the “Select a size and material:” drop-down, choose “pipe-10 S

in-push on-ductile” : =
Hit “Pipes and Bends” Water v B

C.

d. Use a Center OSNAP to start in the center of Circle A. | —

e. Continue clicking near the center of Circles B, C, D, E, and F

f.  From the “Add Fitting” drop-down, choose “tee 10 in x 6 in”, click St T
the “Add Fitting” button and click along the pipe near circle G to (% Eisting Topa ¥ |@|
place the Fitting. )

g. Click along the next pipe near Circle H to place another one. ’fh?nmentnam: e

h.  Under “’Select a size and material:”, choose “pipe-6 in-push on- 2. SEANIEL DR: v |§|

ductile” and hit “Add Pipes and Bends” Pressure Pipe Label Style:

i.  Startfrom the tee near Circle G and create a lateral to the building o > @B+ |FQ|
by snapping to the building outline. =
j- From the “Add Appurtenance” drop-down, choose the 6” valve in Fitting Label Style: -
the list, click the “Add Appurtenance button and select along the <nones - [® -| |_F'Q|

newly created 6” pipe to place a valve.
. . . . Appurtenance Label Style:
4. Examine Pressure Network in the Object Viewer <none> - @+ [
a. Inthe Prospector, under “Pressure Networks”, right-click on “PROP —
WATER” and choose “Select”
b.  From the context tab or the right-click menu, choose “Object
Viewer”

OK | | Cancel | | Help |

5. Save and close the Drawing

65



Proposed Ground Modify  Analyze View Manage Output
e 3 Different types of tools for building Proposed Ground in Civil 3D fy * ] Pawcel Tunusn
2 :
—  Grading Tools : : ¥ Poi Feature Line -
—  Corridors a4 =
I fr Surfaces Create Feature Line
—  Surfaces with Breaklines Palettes + Create Ground Data ~ 3

e  Final proposed ground is usually a combination of the above = L :
prop g y 1 Create Feature Lines from Objects

0
Q
=

Feature Lines Create Feature Lines from Alignment
| e 3D linear objects used for Grading footprint, Surface Breaklines, etc.
. . . Create Feature Line from Corridor
q) ®  More intelligent than 3D Polylines
L _ .
S Allow for true 3D curves (no tessellation) Create Feature Line from Stepped Offset
e —  Carry names, styles and can be related to each other
8 e  ‘Home’ Tab> ‘Create Design’ Panel> ‘Feature Lines’> ‘Create Feature Line’
| ] —  Allows Feature Lines to be drawn “on the fly”
o) e  Additional Methods for Creation
(- —  Create Feature Lines from Objects
(q0] —  Create Feature Lines from Alignment
(7)) —  Create Feature Lines from Corridor
e .
O —  Create Feature Lines from Stepped Offset R ———
((b] e  Displayed based on Styles
8 ®  Have Elevation at each vertex
@) e  ‘Modify’ Tab> ‘Design’ Panel> ‘Feature Line’
O — Can edit, add vertices and elevations using the “Elevation Editor”
— Can also create based on other Feature lines using “Edit Feature Lines”
.. Tools (shown later)
(@)
C
'-6 Feature Line Styles u
c [ 11
S e  Accessed from “Settings” tab of the Toolspace, under “General” é T 7 P 5 o A & ¥ 4 B
(D e  Control display properties of Feature Lines (layers, colors, linetypes, etc...) = Station Elevation Length Grade Ahead Grade Back
(=1
e  Create one for each Feature Line type el A | 0-+00.00 148.65' 3.00 -1.05% 1.05%
£ N 0+03.00 149,62 29,83 -1.05% 1.05%
© e  Civil 3D templates contain pre-made styles = A 0+32.83 143,30" 47.30" -1.05% 1.05%
(D) A 0+80.12 148,81 9.93 -1.05% 1.05%
(Vp] A 0+90.06 143.70' 133.85 -1.05% 1.05%
@) A 2+23.91 147,29’ 7.95 -1.00% 1.00%
A 2+31.86 147.22 91.11' -1.00% 1.00%
Q. ry 3+22.97 146.30° 167.10° 2.00% -2.00%
: ry 4+490.07 149,65




EXERCISE NOTES

1. Open “.\Grading\Road Design—Grading.dwg
2. Create Feature Lines from EOP Polyline

a. “Home” Ribbon tab> “Create Design” Panel> “Feature Lines” > “Create Feature Lines from Objects”
b.  Select the Edge of Pavement Polyline for the Parking Lot (blue line) and hit <ENTER>

c. Site: Parking Lot Grading

d. Name: Parking Lot EOP

e. Erase Existing Entities: Checked

f. HitOK

3. Set Elevations of EOP Feature Line

a. “Modify” Ribbon tab > “Edit Elevations” Panel > “Elevation Editor”, and select the EOP Feature Line

b.  Select the row for station 0+00 and choose the “Elevation from Surface” button ?

c. From the drop-down, choose “SPANIEL DR. FG” and hit OK L

d. Repeatc and d above for the last row (station 4+90.07)

e. From the “Modify” Ribbon tab, on the “Edit Elevations” panel, choose “Set/Grade Slope Between Points“

f.  Select the EOP Feature Line

g. For the start point, move your cursor near the end point (NE point that ties into the road) and left click

h.  Hit <ENTER> to accept the elevation

i For .the end point, move your cursor counterclockwise until you come to the next point (Westernmost point) and click
again.

j- Enter a grade of -2 and hit <ENTER>

k.  Select the EOP Feature Line again

l. For the start point, use the point you just ended on (Westernmost point) and hit <ENTER> to accept the elevation

m. For the end point, move your cursor counterclockwise until you come to the Southernmost point (bottom of the fillet).

n. Enter a grade of 1%

0. Select the EOP Feature Line again, select the point you just ended on (Southernmost point), and hit <ENTER> to
accept the elevation.

p.  Move your cursor counterclockwise until you have reached the next point that ties into the road and left click.

g. Hit <ENTER> to accept the default grade and/or elevation.

4. Create Curb & Gutter using Stepped offset
a. “Home” Tab> “Create Design” Panel> “Feature Lines” > “Create Feature Line from Stepped Offset”
Enter an offset distance of 1’ to create a 1’ gutter
Select the EOP Feature Line, and then click to the outside of the parking lot
For the change in elevation, the “Grade” option, type in -2, then hit <ENTER>
Repeat steps a—d above to create the TOC, BOC and edge of Sidewalk using the following parameters:

® Qoo

5. Save the drawing

Offset Distance  Feature Line to Offset Side Elevation Change Type Change Value
0.083 New gutter flow line Outside Elevation difference 0.5
0.5 New TOC line Outside Elevation difference (0}
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Grading Tools in Civil 3D [ -
e  Civil 3D tool for designing proposed ground &*f Gessits Grading g Criteria Sets
e  Grading Objects projected to a Target from a Footprint ‘.1 . : e  Grading Objects created based on Criteria in Criteria Sets
e  Elements include: [‘ J SRR o« Accessed from the “Settings” tab of the Toolspace under Grading
—  Footprint (Feature Line, Lot Line, Daylight from other Grading) e  Criteria Determine how to reach certain Target
—  Daylight Line — Distance
—  Projection Lines —  Surface
— Face —  Elevation
e  Every Grading Object belongs to a Grading Group — Relative Elevation

—  All Objects in group are tied together e  Samples
—  Can create one Surface out of all objects in a Grading Group —  Distance @ Slope
e  Every Grading Group is managed by a Site and is related to objects on that Site — Surface @ Grade

e ‘Home’ Tab> ‘Create Design’ Panel> ‘Grading’> ‘Grading Creation Tools’
—  Set Grading Group
—  Can make a Surface on the fly
—  Select Grading Criteria

—  Create Grading, edit Feature Lines, etc...

Grading Creation Tools

[®]@g| ﬁ@,GmdetoSuﬁace "@%'@"I‘[ﬁ\‘@

Group: Parking Lot and SW Surface: Existing Topo

2]
)
O
o,
@]
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EXERCISE NOTES

1. Continue in “Road Design—Grading.dwg
Create a Grading Group

a. “Home” Ribbon tab> “Create Design” Panel> “Grading” > “Grading Creation Tools”

b. Inthe Grading Creation Tools toolbar, choose the first button on the left to create a Grading Group [El']
c. For the Site, choose “Parking Lot Grading” and hit OK

d. Name: Parking Lot and SW

e. Automatic Surface Creation: Checked

f.  Use the Group Name: Checked

g. Surface Style: Contours 1’ and 5’ (Design)

h.  Tessellation Spacing: 5

i.  Tessellation Angle: 0.5

j- Volume Base Surface: Existing Topo

k.  Hit OK to create the Grading Group, then Hit OK again to close the “Create Surface” dialog

3. Create Sidewalk Grading

a. Onthe Grading Creation Tools toolbar, use the Criteria drop-down to choose “Grade to Distance”, then click (&~
on the “Create Grading” button

Select the BOC Feature line and click a location outside of the parking lot for the side to grade
Hit <ENTER> to accept the default to Apply to the Entire Length

For Distance, enter 5’ and hit <ENTER>

For Format, choose the “Grade” option, then enter 2 and hit <ENTER>

4. Create Grading for grass boulevard outside of sidewalk

a. With the “Create Grading” command still active and “Grade to Distance” still selected as the criteria, choose the
newly created sidewalk edge Feature Line

b. Hit <ENTER> to accept the default to Apply to the Entire Length
c. For Distance, enter 3’ and hit <ENTER>
d. For Format, choose the “Grade” option, then enter 2 and hit <ENTER>

5. Create Grading for Daylighting (cut and fill) to the Existing Topo

On the Grading Creation Tools toolbar, use the Criteria drop-down to choose “Grade to Surface”,
Select the newly created Feature Line on the outside

Hit <ENTER> to accept the default to Apply to the Entire Length

For Cut Format, choose the “Slope” option, then enter 3 and hit <ENTER>

For Fill Format, choose the “Slope” option, then enter 4 and hit <ENTER>

Hit <ESC> to end the command

6. Add Curb, Gutter and EOP Breaklines to the Surface

®ao00o

~0 a0 oo

a. Prospector > “Surfaces” > “Parking Lot and SW” > “Definition” > right-click on “Breaklines” and hit “Add”
b. Name: Parking Lot Breaklines

c. Mid-ordinate Distance: 0.01

d. HitOK

e.

Select the Feature lines for the EOP, Gutter flow line, and TOC and hit <ENTER>
Close the Grading Creation Tools toolbar and save the Drawing
8. Examine in Object Viewer
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Surface
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E

Continue in “Road Design—Grading.dwg

Create a new, blank Surface
a. “Home” Ribbon tab> “Create Ground Data” Panel> “Surfaces” > “Create Surface”

b. Name: FG Composite
c. Style: Contours and Triangles
d. HitOK

Combine Existing and Proposed Surfaces
a. Prospector > “Surfaces” > “Parking Lot and SW” > “Definition” > right-click on “Edits” and choose “Paste Surface”
b. Select “SPANIEL DR. FG” and hit OK

c. Repeat Step a, choose “Parking Lot and SW”, and hit OK

Save the drawing

Use the Properties Palette to change the Style of the FG Composite Surface to “Contours 1’ and
5’ (Design)”

Select the FG Composite Surface and view in Object Viewer
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EXERCISE NOTES

1. Continue in “Road Design—Grading.dwg
2. Launch the Volumes Dashboard
a. “Analyze” Tab> “Volumes and Materials” Panel> “Volumes Dashboard”

3. Create Volume Entry/Surface for the whole site

a. Inthe Volumes Dashboard, hit new entry button il
b. Name: Overall Site Volume ’é:'
c. Style: Elevation Banding (2D)

d. Base Surface: Existing Topo

e. Comparison Surface: FG Composite

f.  Cut Factor: 1.15

g. Fill Factor: 0.95

h. Hit OK

4. Create Volume Entry/Surface for just the Road (using Datum)

a. Inthe Volumes Dashboard, hit new entry button:
b. Name: Road Design Volume
c. Style: _No Display
d. Base Surface: Existing Topo
e. Comparison Surface: SPANIEL DR. DATUM
f. HitOK
5. Create Volume Report in the Drawing A

a. Inthe Volumes Dashboard, hit the “Insert Cut/Fill Summary” button
b. Zoom to an empty area in the drawing near the edge of the Surface and left-click to place the summary

6. Create external Volume Report
a. Inthe Volumes Dashboard, hit the “Generate Cut/Fill Report” button ﬁ
b. Examine the HTML report that appears in the Web Browser window
c. Close the report

7. Save the Drawing Cut/Fill Report

Generated: 2013-01-10 134825
By user: gagnm
X\ Autodesk ProjectsiCivil 3D Projects'2013\Civil 3D 2013 Essentials (Onfine) Data Files|Grading X Autodesk
Drawing: Projects\Civil 3D Projects\2013\Civil 3D 2013 Essentials (Online) Data Files\Grading|Grading - Create Grading -
Finished dwg
5 2d Area Cut Fill Net

2 "

Name Type Cut Factor || Fill Factor Sa.FO) (Cu Yd) (Cu Yd) (Cu Yd)
Overall S | i 1.000 1.000 1998720.66 2727786 85.69 27192.17<Cut>
Votume
Pond
. full 1.000 1.000 78967.04 24479.93 66.83 24413.10<Cut>
Votume
Road
; il 1.000 1.000 4393045 222709 17.65 2209 44<Cat>
Vohume

Totals

2d Area Cut Fill Net
(Sq Ft) (Cu Yd) (Cu Yd) (Cu Yd)

J
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EXERCISE NOTES
1

Open “.1Plan Production|Plan Production—Create View Frames.dwg”

2. Open the Create View Frames wizard
a. “Output” Ribbon Tab> “Plan Production” Panel > “Create View Frames”

3. Set the Alignment

a. Alignment: SPANIEL DR.
b.  Hit Next
4. Set Sheet Type
a. Type: Plan and Profile
b. Template: <Default Path>\Civil 3D (Imperial) Plan and Profile.dwt
c. Layout: ARCH D Plan and Profile 20 Scale
d. View Frame Placement: Along Alignment
e. Set the first view frame before the start of Alignment by: On and set to 30’
f.  Hit Next
5. View Frame Group Properties
a. Name: SPANIEL DR. VIEW FRAMES
b. Label Location: Top Left
c.  Hit Next

6. Match Line Properties

a. Snap Station Value down to nearest: 10
b.  Additional Distance for repositioning: 30’
c. Left Label Location: Middle
d. Right Label Location: Middle
e. Hit Next
7. Profile View Properties
a. Style: CADD-Full Grid with 5X Exag
b. Band Set: _No Bands

c. Hit Create View Frames

8. Save the Drawing
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EXERCISE NOTES

1. Continue in “Plan Production—Create View Frames.dwg”

2. Open the Sheet Creation Wizard
a. “Output” Ribbon Tab> “Plan Production” Panel > “Create Sheets”

3. Set View Frame Group Options

a. Group: SPANIEL DR. VIEW FRAMES
b.  View Frame Range: All
c. Layout Creation: All Layouts in the current drawing
d. Layout Name: Plan and Profile - <[Next Counter(CP)]>
e. Choose North Arrow block: North
f.  Hit Next
4. Set Sheet Set Options
a. New Sheet Set: Huntsman's Ridge
b.  Sheet Set Storage Location: C:\Civil 3D Projects\Civil 3D 2018 Level I\
c.  Hit Next
5. Profile View Options
a. Get other settings from an existing Profile View: SPANIEL DR. PROFILE
b.  Alignment: Align Profile and Plan View at start

c. Hit “Create Sheets”
d. Hit “OK” on the message save drawing message

Zoom to a blank area in the drawing above the SPANIEL DR. PROFILE to place the smaller Profile Views.

Edit the Elevations on the Profile Views to fit the pages better

a. Select the first Profile View, right-click and choose “Profile View Properties”
b.  On the “Elevations” tab, choose “User Specified”

c. Setthe Minimum to 115’ and the Maximum to 145’, then hit “OK”

d. Repeat Steps a—c for the remaining profiles to set new elevations:

Profile View Minimum Elevation Maximum Elevation
Second 120° 150’
Third 125’ 155’
Fourth 130’ 160’

8. Adjust the Profile Viewports on the Sheets

Select the first Plan & Profile layout tab

Double-click in the Profile Viewport to activate it and unlock it
Use the PAN command to center the Profile in the Viewport
Relock the viewport

Repeat a—d for all of the Layout tabs

P00

9. Save the Drawing
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Points & Point Management

. . e
Point Creation Tools = & Point Creation Tools

e Point Creation Tools are found on ‘Home Tab »
‘Create Ground Data’ Panel
— Panel Tools include:

Various Point Creation Tools (which
open the Create Points toolbar)
Point Group Creation (covered later)
COGO Point Creation
Point Conversion Tools
— To Create Points:
Choose Tool
Specify Location
Enter Name/Description
Specify Elevation

Style is assign by default setting, Point
Group, or Description Keys on the fly

= Create Points Toolbar
—  Creation Pull-downs:

Include Miscellaneous, Intersections,
Alignment, Surface, Interpolation, Slope,

and Import Points
— Point Creation Settings:

Include Default Layer, Point Creation Command Defaults, Default Styles,
Default Naming, and Point Identity

eate Points
-] - ov &~ &

Local Coordinates

Grid Coordinates
Geographic Coordinates
Prompt For Elevations
Prompt For Peint Mames
Prompt For Descriptions
Default Elevation
Default Description

Disable Description Keys

B 9" Default Styles

Pa e

B 9" Default Name Format
Point Group Name Template
Paint Mame Template

1“9 Point Identity
Mext Point Mumber
Use Sequential Mumbering
Paint Mumber Offset
Sequence Point Mumbers From
If Point Murnbers Are Supplied
Force Mames
If Point Mumbers Already Exist
If Point Mames Already Exist
If Point Mumbers Need To Be ...

Command: Measure Object

Match On Description Paramet...

Echo Coordinates to Comman...

Marthing - Easting

Grid Morthing - Grid Easting
Latitude - Longitude
Automatic

Maone

Mone

0.00¢

EOP

True

False

True

Point Group - (<[Mext Counter(CP]]>)
Point - (<[Mext Counter(CP]]>]

True

Use

False

Notify

Motify

Use next point number

BB
Parameter | Value
2 EZlDefault Layer
Layer Y-NODE
= Points Creation




Open “C:ICivil 3D Projects|Civil 3D 2018 Survey|Class Survey.dwg”
2. Start the “Create Points” Command

a. Onthe “Home” tab of the ribbon, on the “Create Ground Data” Panel, choose “Points”, then “Create Points
Miscellaneous”, then “Manual”

~

3. Change the Command Settings o
a. Inthe “Create Points” Toolbar, hit the Chevron symbol at the far right of the toolbar to expand the options.
b.  Expand the “Default Layer” option and make sure this is set to “V-NODE”
c. Examine the other settings

4. Create at least 6 Points with Miscellaneous [ Manual

a.  With the Toolbar still open and active, click anywhere in the drawing to create a new point.

b.  For the description, enter CTREE and hit <Enter>
c. Atthe elevation prompt, assign any elevation you want and hit <Enter>
d. Repeat steps a—c to create 5 more points using these Descriptions: CTREE, DTREE, GRND, MH
e. Hit <Enter> again to end the command
5. Create EOP Points from Line
a. Use the 3DPoly command to create a 3D polyline to represent an Edge of Pavement
b.  Use the Properties palette to set one or more elevations along the vertices
c. Inthe “Create Points” Toolbar, expand the “Points Creation” section.
d. Set “Prompt for Elevations to “Automatic”
e. Set “Prompt for Descriptions” to “Automatic” and for the “Default Description”, type in EOP.
f.  From the first button on the Toolbar, use the drop-down arrow to choose “Polyline Vertices—Automatic”
g. Select the polyline you just created.
5. Examine Points List in Prospector
a. Inthe “Prospector”, click on “Points”
b. Inthe “ltem View” at the bottom, right-click on any point and choose “Zoom To”
6. Save the Drawin
‘ X258.00

CTREE

X258.00 X257.00
EQF DTREE

X256.00 % X257.00
CTREE 207.50 MH
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Points Styles
= Control display properties of Points
— Symbol/Marker Block
— Block Rotation/Scale
— 3D Display Mode
— Marker and Label layers and visibility
* Create one style for each point type
= Used for grouping and in Description Keys (Covered Later)
= Civil 3D templates contain some pre-made styles

7t Master View

=-[ Drawingl

ﬁﬁﬁ‘ General

E‘@’ Point

--IE? User-Defined Property Classifications
5 Label Styles

— Content and layout of text "E‘ Point File Formats

— Text height, color, justification "E‘ Description Key Sets

— Dragged state of label (leader creation, arrowhead, etc...) & External Data References
= Create one for each label type/setup you need
= Civil 3D templates contain pre-made styles

Point Label Styles

= Control display properties of Point Label Elements
— Text Style, Orientation
— Label visibility

i (& Table Styles
®-E Commands
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Points & Point Management

Create/Edit Styles - Multiple Commands

* Point right-click menu (drawing or Prospector)

= Point Group Properties dialog (right-click from drawing or Prospector)
= Settings Tab (right-click)

= Create New or Copy Existing and rename

Apply Point and Label Styles
* Point Styles and Label Styles can be applied through Point Groups or Description Keys (Covered Later)
* Change Point Styles using Prospector Item View for individual
= Change Point Label Styles
— Right-click on point in drawing or prospector, hit “Label Properties”
— Can change which style is applied or change properties of current style

I

Mame

Description

Created by

%@V Basic

Autodesk, Inc.

I=ﬁ§|B»anchr'rmrk

Style for benchm

Autodesk, Inc.

@@Bound

Style for bound.

Autodesk, Inc.

%@Catch Basin

Style for catch ba

Autodesk, Inc.

<t Drill Hole

Style for drill hole

Autodesk, Inc.

%@Gas‘u’alve

Style for gas valve

Autodesk, Inc.

%@Guy Pole

Style for guy pole

Autodesk, Inc.

l=ﬁ§|H|:|riz|:|ntz|| Cu

Style for horizont

Autodesk, Inc.

@@ Hydrant (exist

Style for existing 1

Autodesk, Inc.

=§§| Hydrant (prop

Style for propose

Autodesk, Inc.

%@Imn Pin

Style for iron pin.

Autodesk, Inc.

=‘.§§| Sanitary Sewel

Style for sanitary

Autodesk, Inc.

<5 Shrub - 5ft

Style for shrub - £

Autodesk, Inc.

%@Sign (single pe

Style for single pe

1| mn

Autodesk, Inc.




1. Create a new Point Style
a. On the “Settings” tab of the Toolspace, expand “Point”, the Point Styles
b.  Right-click on “Tree” and hit “Copy”
c. Inthe dialog that appears, go to the “Information” tab and change the Name: to “Deciduous Tree”.
d

On the “Marker” tab, in the “Use AutoCAD BLOCK symbol for marker” window, scroll to the right and click on
“Shrub 2”

e. Change the Size “Options” to “Use Drawing Scale”. Set the “inches” to 0.2
f.  Examine the other settings on the remaining tabs, then hit “OK”

2. Apply Point Styles to different Points
a. Inthe drawing, select the point you creating using the DTREE description.
b. Right-click and choose “Edit Points”

c. Inthe dialog that appears, scroll to the right to find the “Style” column and change this to the new “Deciduous
Tree” Style you just created. Notice the change in the point in the drawing.

d. Hit <ESC> to unselect the point
Repeat steps a—d above to assign a new style to one additional point.

3. Apply Label Styles to different Points
a. Inthe drawing, select the point you created using the DTREE description.
b. Right-click and choose “Edit Points”

c. Inthe dialog that appears, scroll to the right to find the “Label Style” column and change this to “Elevation and
Description” Notice the change in the point in the drawing.

d. Hit <ESC> to unselect the point
e. Repeat steps a—d above to assign a label style to one additional point.

4. Save the drawing
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Point Group Creation 2 Ty
= Point Group Creation Tools are found on Home’Tab » ‘Create Ground
Data’ Panel » ‘Points’ Tool

Point Groups
* Organize points with common properties including:
— Name
— Function
= Point group properties can be used to control Style of points within the
group
= Create multiple point groups for different point types based on:

— Number Illllll-lll;'llll-lllllllll.'
— Name reate Point Group k‘
— Elevation -
— Raw Description
— Full Description

= Multiple Point Groups can be added to one Point Group

* Points with matching properties are automatically added to point groups

upon creation of the point
= Point Groups can be set up and saved in drawing templates

Point Groups

ing

Control Points using Point Groups
* Change Point and Point Label Styles p
= Assign Group to Surface definition (covered later) A, Point Group Properties - Spat Elevations
= Override individual Point properties
= Display list of Points in Group

= Lock/Unlock Points Mame:

* Delete Points Spot Elevations
= Export Points

= Change Display Order

—
©
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==

Information lPoint Groups I|Raw Desc Matching I|Ir|dude IlExdude I|Query Builder I|0\rerrides I|Point List IlSummary I

Description:

®  Prospector> Point Group “Properties” (from right-click)

Default styles
Puoint style:

ﬁ‘jlmnPin - -

Point label style:

éfl'::‘ On Blevation - Point Blevation 8D

[”] Object locked

Points & Point Management




1. Create a “Trees” Point Group
a. Inthe “Prospector” tab of the Toolspace, right-click on “Point Groups” and hit “New”

b.  On the “Information” tab of the dialog, change the “Name” to “Trees”

c.  On the same tab, change the “Point Style” to “Tree” and the “Point Label Style” to “Description Only”

d. On the “Include” tab of the dialog, put a check next to “With raw descriptions matching:” and enter “*“TREE*” (without
the quotes)

e. Click on the “Point List” tab to see the points that are currently in the drawing that will be included in the Point Group

based on these settings.
f. Hit“OK”
2. Create a “Pavement” Point Group
a. Inthe “Prospector” tab of the Toolspace, right-click on “Point Groups” and hit “New”

b.  On the “Information” tab of the dialog, change the “Name” to “Pavement”

c.  On the same tab, change the “Point Style” to “Iron Pin” and the “Point Label Style” to “Point#-Elevation-Description”

d. On the “Include” tab of the dialog, put a check next to “With raw descriptions matching:” and enter “*EOP*” (without
the quotes)

e. Click on the “Point List” tab to see the points that are currently in the drawing that will be included in the Point Group
based on these settings.

f. Hit“OK”

3. Create a “No Display” Point Group

a. Inthe “Prospector” tab of the Toolspace, right-click on “Point Groups” and hit “New”

b.  On the “Information” tab of the dialog, change the “Name” to “_No Display”

c.  On the same tab, change the “Point Style” to “<none>" and the “Point Label Style” to “<none>"

d.  On the “Include” tab of the dialog, put a check next to “Include all points”

e. On the “Overrides” tab, put a check in the boxes next to “Style” and “Point Label Style”

f.  Hit “OK”. Notice that all of the points in the drawing have disappeared. This is because they have now all been set

to Point Style and Point Label Style of <none>, and this setting is an override.
4. Change Display Order of Point Groups
a. Inthe “Prospector” tab of the Toolspace, right-click on “Point Groups” and hit “Properties”
b. Inthe dialog, select the “Trees” Point Group and use the arrows on the right to bring it to the top.
c. Hit“OK” and notice that now only the Trees appear
d. Repeat step b to move the “Pavement” Point Group to the top.
e. Hit “OK” and notice that now the Pavement and Tree points are visible.
f.  Repeat step b to move the “_No Display” Point Group to the bottom of the list.
g. Hit“OK” and notice that now all points are visible.
Save the drawing

n Point Groups * n Point Groups »

4 Wl [

] Name Description MName Description

o I | e T

[#] pavement I:> Trees

[#] Trees ﬁ} R“:’] _All Points

[#] _anpoints I [%] o Display Q?
& &

oK Cancel Apply Help 0K Cancel Apply Help
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Points & Point Management

Description Keys
= Control properties of points upon Creation or Import
— Point and Label Styles
—  Description
— Layers
= Assigned based on Raw Description
— Point Style
— Label Style
— Layer
— Raw to Full Description Conversion
* Determine Scaling and Rotation
= Organized into Description Key Sets

Create Description Keys
= Create Description Key Set (Settings tab - right-click)
— Can have multiple Sets per drawing
—  Control Display Order of Description Keys
= Create Description Keys within Key Set (Edit Keys)
— Edit Keys
— Set Point Style, Label Style, and Layer
—  Set Format of Full Description, use of Parameters

I Note: Description Keys override the Point Styles
kil assigned to the Point Groups because they
assign a Point Style to the individual Points. The
only way for a Point Group to override the Point
Style assigned by a Description Key is by placing
a check in the Override tab of the Point Group
Properties dialog for Point Style (as shown here).

TOOLSPACE

Active Drawing Settings View -

=-[ Drawingl -
ﬁﬁﬁ' General

EI'@' Point

--E? User-Defined Property Classifications

-[EF Point Styles

<[ Label Styles

-[=F Point File Formats

[ Description Key Sets

Settings

m

""" = External Data References

i-(2 Table Styles

- Commands
""""*E?-.fvn-f'_f-wf“f‘ff ‘j‘-}‘f"_f"f'\f”j‘._!,*‘.r~f

i’

=gy

|Ir1fcrrr|ation I|PointGroups I|Raw Desc Matching I|Indude I|Exdude I|Query Builder | Overrides IPoint List I|Summary I

Property Override
| [‘3’] Raw Description ¥
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Exercise

Create Description Key Set “Survey Keys”
a. From the “Settings” tab of the Toolspace, expand “Point”, then “Description Key Sets”

Right-click on “Description Key Sets” and choose “New”. Type in “Survey Keys’ and hit “OK”

Back in the “Settings” tab, under “Description Key Sets”, right-click on “Survey Keys” and choose “Edit Keys”
Right-click in the first row of the Panorama that appears and choose “New”

Use the Screen Shot below to create the necessary Description Keys. Make sure to pay close attention to the
settings in every column.

When you have completed the Keys below, close the Panorama

® Q00T

Style Point Label Style Format Layer Scale Parameter  Fixed Scale Factor  Use drawing scale  Apply to X-Y

[¥] Tree [¥] Description Only & [#] V-NODE-TREE [¥]Parameter 1 []1.000 [INe [INe [INe
STA Point#-Elevation-Description  §* V-CTRL-TRAV Parameter 1 []1.000 [ONe [ONe [INe
Tree Description Only S1FT DI& CYPRESS V-NODE-TREE Parameter 1 []0.083 [INa Yes [INo
[¥] Deciduous Tree [¥] Description Only g [¥] V-NODE-TREE [v]Parameter 1 []1.000 [INe [INe [INo
[¥] Tree [] Description Only & [#] V-NODE-TREE [¥]Parameter 1 []1.000 [INe [INe [INe
[#] 5TA [#] Point#-Elevation-Description | §* [#]V-CTRL-HCPT [#] Parameter 1 []1.000 [ Ne [ Ne [INe
[¥] Storm Sewer Manhole [#] Point#-Elevation-Description  §* [#¥] V-NODE-STRM [#] Parameter 1 []1.000 [INe [INe [INe
[¥] Tree [¥] Point#-Elevation-Description  §* [¥] V-NODE-TREE [¥]Parameter 1 []1.000 [INe [ Ne [No

2. Create Points using these Description Keys
a. From the “Home” tab of the Ribbon, choose “Points” > “Create Points” > “Miscellaneous”.

b. Inthe Toolbar that appears, expand the settings and under “Point Creation”, set “Prompt for Elevations” and “Prompt
for Descriptions” to “Manual”.

Use the command to create a point that has the description of SWMH
Notice that a symbol and layer are automatically assigned
Use the same command to create a point that has the description of bc (lower case)

Click on the two new points, right-click and choose “Edit Points”. Review the Panorama and notice that a Point Style
and Label Style have been assigned

=0 ao0

3. Save the drawing

©
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Data Contained in Civil 3D Survey Database

Central data store for all survey-specific data in a project
— Contains all control points, known directions, observation measurements, traverse definitions, figures,
and standard deviations based on equipment data
— Data either imported from data collector or created manually
— Stores Angles in Radians and Distances in Meters
— Drawing units and coordinate zones can be independent of Survey Database Units
— Data is transformed on the fly
— Data can come from multiple sources
Databases keep data separate from drawings
—  Prevents unwanted changes/edits
Right-click on “Survey Databases” on Survey tab of Prospector and hit “New Local Survey Database”
Can be accessed from multiple drawings attached to the Survey Database
Must Open Database before you can use its data in a Drawing

Networks

Collection of related control points, instruments setups, observations, and traverses
—  Stored in Survey Databases
— Database can contain multiple Networks
— Networks can contain data from multiple data sources

Equipment Databases

Contains one or more equipment definitions
— EDM Values
—  Prism information

TOOLSPACE

-1 & &
= = el

Elﬁ‘é Survey Databases
- W ATCS Test

?é Lorton Road
?é Mew Boston

EIQ Import Events
- £ Tract 1_Bndy.fbk
-- Q Tract_2_Bndy_w_Hse_Sites.fbk
T Survey Queries
EIIH Metworks
IH Control
[Iﬁ] Metwork Groups
EJ--E; Figures
[ES] Figure Groups
EZI--'E} Survey Points
EE] Survey Point Groups

7p)
(b
7))
©
@]
@©
e
©
)
>
()
>
—
-
0p)

— Standard Deviations
—  Etc.. A Equipment Database M

EIF’Q Equipment Databases

&
=]
1k
m

E Boom ooy [ Sample
b Figure Prefix Databases bt s =& Figure Prefix Databases
= Collection of Code Prefixes er=r=m— é& ACME
E —  Establishes which codes are used for __ ':_""’Ih m,
D linework creation e g ATCS
—  Establishes settings and Style for all figures iiames Sample - & Cvi1-4
@ : i Description
(Layer, Style, Creation Type, etc.) b -r& P
@© * Codes stored in Figure Prefix Databases i Lmdt =] sample
(- - g?fn have n;ultiple databases set up for E'“T”‘E g‘e"e' O BODMIVESS - &4 School
ifferentcodesete || i ngle eqgrees £ i
CU ifferent code sets o Angle EI--I%I Linework Code Sets
E - Horizontal collimation 0.0000000 g ATCS
- Angle type Right u
(q0] - Vertical collimation 0.0000000 [ & sample
) - Vertical angle type Zenith
(q0) £} Electronic Distance Meter (EDM) PSR T i N A NPRPT SR o AN L R A N N
‘ l - Refractive index 28796000000
- Wave constant 105.45000000
> - Offset 000000000
q) - Measuring Device
| -
-




1. Create and Open Survey Database
a. Inthe Surveytab of the Toolspace, right-click on “Survey Databases” and hit “New Local Survey Database”

b.  Enter “Class Database” in the dialog that appears
c. Ifitis not already shown in bold, right-click on new Survey Database and hit “Open Survey Database”

2. Examine Equipment Database
a. Inthe Surveytab of the Toolspace, under “Equipment Databases”, expand “Sample”
b.  Right-click on the “Sample” Equipment.
c. Examine the settings and make any desired changes in the dialog.

3. Create Figure Prefix Database
a. Inthe Surveytab of the Toolspace, right-click on the “Figure Prefix Databases” and hit “New”

b.  Type “Class” in the dialog that appears and hit “OK”

Note: We will create the figure prefixes in a future exercise

i

A Figure Prefix Database Manager - ACME
ap
Name Breakline Lot Line Layer Style Site
[ cL [#] Ves [INo £E C-ROAD-CNTR |+ |3 Road Centerline | |BfSurvey Site [+]
[E2EP Yes [INo £EV-ROAD_EOP |+ [BgEdge Pavement Survey Site |- |
[EFC Mo [INo £EV-SITE-FNCE |+ [BgFences Survey Site =
[22 sw Ves [INo £EC-TOPO-FEAT |+ |83 Standard Survey Site |- | |
{22 HOUSE [#] Ves [INo £ZV-BLDG-OTLN |+ [BB5Buildings Survey Site |-
[22 SHED [#] Ves [INo £ZV-BLDG-OTLN |+ [B25Buildings Survey Site |- |
{22 BRN [#] Ves [INo £EV-BLDG-OTLN |+ B3 Buildings Survey Site =
[22 CNTRL Mo [INo £EV-CTRL-TRAV |+ |25 Control Survey Site |- |
{22 TRACT Mo [INo £EC-PROP-LINE |+ [BB3Boundary | Survey Site =

I CK ] | Cancel | | Help
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Survey Data Management

User Settings
= Accessed from Survey tab of the Toolspace

— Choose the button at the top-left of the tab ﬁﬁ
= Specific to a user
= Set preferences for Survey data only
— External Editor
—  Current Equipment and Figure Prefix Databases
—  Settings for interactive graphics
— Etc..

Survey Database Settings

= Accessed from the ‘Survey tab of the Toolspace
—  Survey Database must be Open
— Right-click on Database name and choose

“Edit Survey Database Settings”
= Specific to individual Survey Database

e sy

- ATCS Test

TOLSPACE

W hewboson

-1 R &
o = =l

h‘- Databases
ﬁﬂ Lorton Road

EI Q Import Events
- - & Tract 1_Bndy.fbk
- &) Tract_2_Bndy_w_Hse Sites.fbk

----- F'? Survey Queries

,

o |

= Set preferences for.Survey onIy” e hvements
— Database Units and Precision oot W 5
—  Default Measurement Types Groups
—  Corrections Property Value
—  Etc.. - FF Units | N R N e N ™
- Coordinate zone =Mone> |E|
- Distance US Foot hd
- Angle Degrees DMS (DDD.MMS5ES) | | 8
- Direction Bearings -
- Temperature Fahrenheit -
Pressure Inches Hg -
Precision

Angle

- Distance
- Elevation
- Coordinate

- Latitude and longitude

Measurement Type Defaults

- Angle type
- Distance type
- Wertical type
- Target type

Measurement Corrections

- Curvature and refraction

- 5ea level

Angle

Slope

WVertical Angle

Prism

1Mo

[ Mo




1. On the Surveytab of the Toolspace, choose the “Edit User Settings” ﬁﬁ button

2. Set the current Survey Equipment Database
a.

Set the “Current Equipment Database” to “Sample”

3. Set the current Survey Figure Prefix Database
a.

»

Set the “Current Figure Prefix Database” to “Class

n Survey User Settings

et W&

Property Value
—ﬁ Miscellaneous ~
- Use external editor Yes
- Buternal editor Ch\Windowshsystem32\notepad. exe Ea
- Preview vertical exaggeration 1.00000000
—ﬁ Survey Database Defaults
- Survey database settings path C:\ProgramData‘-.Au.tndesk\CBD 2016\enui.. EE'.
- Survey Database Settings ~
- Extended properties definition path C:\ProgramDa'ta\.Au.tndesk\CBD 2016\enui.. EC—J'.
- Extended properties definition Sample ™
—ﬁ Equipment Defaults .
- Equipment database path C:\ProgramData’\Autodesk\C3D 2018 enuh... EE,'.
- Current equipment database Jf"'QSample ~
- Current equiprment Sample ~
—ﬁ Linework Processing Defaults .
- Linewerk code sets path C:\ProgramData\Autodesk\C3D 2016 enut... £
- Process linework during import [#] Yes
- Current linework code set Sample ~
- Process linework sequence By import order ~
—ﬁ Figure Defaults
- Figure prefix database path C:\ProgramData\Au.tndesk\CBD 201 Bhenul... EEI.
- Current figure prefix database S_‘:CIass Figures ~
- Figure style EﬁStandard ~
- Figure layer gﬁ |
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Survey Data Management

Network Styles
= Control display properties of Networks
— Known Control Points
— Unknown Control Points
— Sideshot Points
— Network Lines
— Direction Lines
— Sideshot Lines
— Error Ellipses
= Create one for each Network Type
= Civil 3D templates contain pre-made styles

Figure Styles
= Control display properties of Figures
— Figure Lines
— Vertex Markers
— Midpoint Markers
—  Endpoint Markers
— Additional Markers
= Create one for each Figure type
= Civil 3D templates contain pre-made styles

Create/Edit Styles - Multiple Commands

= Network or Figure right-click menu (drawing or Prospector)
= Settings Tab (right-click)

= Create New or Copy Existing and rename

Apply Network and Figure Styles
* Network and Figure Styles applied during creation or changed later
* Change Network and Figure Styles using Prospector ltem View

Active Drawing Settings View
--E:J Pipe
-- ﬁ Structure
ﬂlﬂ Pressure Metwork
f Pressure Pipe
53 Fitting
tﬁi Appurtenance
-- Corridor
:: : Intersection
[% Assembly
% Subassembly
E@ Quantity Takeoff
o 5

f‘ .;;J’

EI [= Metworks E

22 Network Styles
IEDEP Basic
== Figures
== Figure Styles
: Basic
Buildings
Curb
Fences
Road Centerline
¥ Standard
E[ﬁ Treeline
= [EF Label Styles
--E? Figure
--I.E? Line
-2 Curve
(= Com

R

Settings

m

-,.f-,\_,».,,SF”.‘}?_’,;_;.ﬂ,jh FAvS

"




Exercise

1.

Create new Figure Styles

a. In the “Settings” tab of the Toolspace, expand “Survey’, then “Figures”, then “Figure Styles”
Right-click on “Curb” and hit “Copy”

b.
c. On the “Information” tab, change the Name to “EP”
d

On the “Display” tab highlight all of the components and click under the layer column. Choose “C-ROAD-FEAT” and

hit “OK.

e. Repeat this step for all of the other View Directions.

f. Repeat steps a—e to create a style called “Sidewalks” that uses the layer called “C-TOPO-FEAT”
g. Repeat steps a—e to create another style called “Lots” that uses the layer called “C-PROP-LOTS”

2. Create Figure Prefixes using Styles

a. Inthe Surveytab of the Toolspace, under “Figure Prefix Databases”, right-click on “Class” and hit “Manage Figure

Prefix Database”

a. Hitthe ':EF' button to add a new Figure Prefix

a. Enter the Prefixes and settings below, hitting EII}' each time to add a new Prefix:

A Figure Prefix Database Manager - Class

ey

MName Breakline
[2: BLDG [ Ves
[Zep [l Ves
[3TC [ Ves
[%: SDWK [¥] Ves
[2: GBF CONo
[2:BC [#] Yes

Lot Line
[MNe
[Me
[IMa
[ MNe
[#] Yes
[IMe

Layer
££V-BLDG-OTLN
£FV-SURV-FIGR
££V-SURV-FIGR
££V-SURV-FIGR
£FV-SURV-LINE
££V-SURV-FIGR

Style
[ =g Buildings
|~ |Daep
EE@Curb
| = | By Sidewslks
EE@Lots
EE@Curb

Site

IZ| Survey Site

Ok

] | Cancel | |

Help

NOTES
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Two Connection Options  W—
1. Survey Data Collection Link 8
2. Third-Party Link add-ons

t

ICa

1. Survey Data Collection Link %
=  Same tool that was in Land Desktop’s Survey extension
*  Accessed from the ‘Homeée tab » ‘Create Ground Data’ Panel » ‘Survey Data
Collection Link’ B import Survey Data
Transfer Data to/from Data Collectors B e RS R st
Import/Export Options 1 ELr-:I Survey Data Collection Link & opl[20 Witeframel
Perform file conversions where necessary w " "Lieate Dicung Data
Supported Input Formats
—  AutoCAD DXF — SMI
— AutoCogo — Leica GSI Raw, GRE3

—  ASCII (User-defined, ASCII 2, etc.) —  WILDSoft : -
— oM — SurvCAD 1sfer | Conversions _thlﬂ-ns Geodetic Tou_-_li_"%cj

— Autodesk-Softdesk FBK — PacSoft Coordinates ? @.

—  Sierra Cybernetics — MapTech . .
—  Draftix —  MTI ——  Merge Coordinate Files... —

— TDS_ .raw, .rw5, .cr_5 — Lewis & Lewis Generate DTM fram DXF...
—  Sokia SDR Numeric 4, Alpha 14 — C&G
— Topcon FC-4, DL-100 Digital Level, -

GTS210/220/310 Raw Survey Pro JOB File Import/Export...

Mikon Import/Export...
2. Third-Party Link add-ons Trimble DC File Import/Export...

*  Add-ons to Civil 3D:
—  Trimble Link

=  Often downloadable from respective company websites ]

=  Specific commands for working with individual brand models. ~ Input
Correert
{” Coordinate File  (* Baw Datafile ¢ TDS Faw Archive ——_—J

Cloze I

Input Type: ITDS Raw Data [.nwd] _v_] Help I

Input File Mame: ;I:'\Eivil 30Survenh 201544 Clazs Filezh\Raw D

Choosze File... I

-
=
&
&
@)
O
S
0
Q@
O
O
2
©
]

— Output

COutput Tepe: i.&utudesk-s oftdezk FBE Ll

Output File M ame:; il:'\EiviI 30MSurvet 20155 Class Files\Partzm

Survey Data Management




Open Survey Data Collection Link
a. On the “Home” tab of the Ribbon, hit the down-arrow next to the name of the “Create Ground Data” Panel and
choose “Survey Data Collection Link”

Convert raw data to FBK
From the “Conversions” menu, choose “Convert File Format”

a.
b
c.
d.
e
f.

g.

Repeat Step 2 for “topo2.rw5”

a.
b.
c.

Input:

Input Type:

Input File Name:
Output Type:
Output File Name:
Hit “OK”

Input File Name:
Output File Name:
Hit “OK”

Raw Data File

TDS Raw Data (.rw5)

C:\Civil 3D Projects\Civil 3D 2019 Survey \Raw Data\Portsmouth Heights.rw5
Autodesk-Softdesk FBK

C:\Civil 3D Projects\Civil 3D 2019 Survey \Portsmouth.fbk

C:\Civil 3D Projects\Civil 3D 2019 Survey \Raw Data\topo2.rw5
C:\Civil 3D Projects\Civil 3D 2019 Survey \Topo2.fbk

Examine the two Fieldbooks that were created

| ] Survey Link DC 755

File View _ Conversions  Options  Geodetic Teols Help

Get File... !

Manage files with Server Mode...

Test Wizard...

Advanced...

Send and Receive files from Data Collector
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Import Survey Data Wizard
* “Import Survey Data” command

— Located on the ‘Home’tab in the ‘Create Ground Data’ Panel

*OR*

— From the Surveytab of the Toolspace, right-click on “Import Events” under the desired Open Survey Database

* Wizard steps through necessary options for data insertion into Survey Database and
drawing

— Choose/create Database

—  Specify import file type, format, and name

— Choose/create Network

— Import Options

Import Settings and Options
* Must be imported into an existing Network
— May have one network per import file (Control, Sideshots, etc...)
= Can show previews as the data is added to the database
— Caninsert data (points and figures) during import or later from right-click menu

TOOLSPACE

Import File Formats
* Fieldbook (.fbk) file

T
®)
Q.
£
©
e
©
A
>
)
>
|
-
(7))

* LandXML
* Point File (ASCII) B W ey Db
- ATCS Test
T ) et
- i fizi Lorton Roa
== Specify Database Specify the import settings for the selected data source. H
Import settings R‘é NEW' EDEtCIﬂ
Specify Data Source i
fé Mew Haven Test
Specify Metwork Property TR EI ﬁbé SITE MG

} Import Options Field book filename (.FBK) I\ Civil 3D\Survey 201544 Class Files\Tract_1...
- Current equipment database LF"Q

- Current equipment @-

- Show interactive graphics Yes
- Current figure prefix database éﬁ Class
- Process linework during import [ MNe [IH] Metwo

Current linework code set ATCS

- Process linework sequence By import order EI Figure @l Zoom to
- Import event name Tract_1_Bndy.fbk [IES] Figure %’I’Gn Pan to

- Import event description

- hssign offset to point identifiers [INo -E} Su ey Refresh

- Point identifier offset
Insert network object [#] Yes EE] SU NE} FUTITOTOUES

- Insert figure objects [¥] Yes .Ih'__y _ﬂ""'-...lif‘lrf"u.ay’ J?‘S.-Jf' jl"' _j'.,,__!/ S P

- Insert survey points [ MNe

Points

- Display telerance errors in Event Viewer [ Mo

= Points from Drawing

Survey Data Management




1. Create Network
a. On the “Survey” tab of the Toolspace, expand the “Class Database”.
b. Right-click on “Networks” and hit “New”
c. In the dialog that appears, type in “TRACT-1” and hit “OK”

2. Import Fieldbook
a. From the ‘Home’ tab of the ribbon, on the “Create Ground Data” Panel choose “Import Survey Data”
In the dialog that appears, choose the “Class Database” Survey Database and hit “Next”
For the “Data source type”, choose “Fieldbook” file.
Browse to C:\Civil 3D Projects\Survey Class, choose “TRACT_1_BNDY.fbk” and hit “Open”, then hit “Next”
Choose “TRACT-1" Network and hit “Next”
Set “Show Interactive Graphics” to “Yes”
Make sure the “Current Figure Prefix Database” is set to “Class”
Uncheck “Process Linework During Import”
Make sure “Insert Network Object” and “Insert Figure Objects” are both set to “Yes”
Set “Insert survey points” to “No”
Hit “Finish”
Watch the preview as the data is added.
Examine data in Survey tab

mFT T S@mooo00T

-3.—

3. Insert Survey Points

a. Back on the “Survey” tab of the Toolspace,
expand “Networks”, then “TRACT-1" &

b. Right click on “Control Points”, choose
“Points”, then “Insert into drawing” x

c. Repeat b for Setups and Survey Points
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H TOOLSPACE i -
Least Squares Analysis - [~1Mop]i2D Wireframe]

* Run on one Network at a time
— Uses Observation Equation Method
— Adjustments made to Points in the Survey Database and any resulting linework
= From the ‘Survey” tab, right-click on a Network, choose ‘Least Squares Analysis”, then
“Perform Analysis”
— Dialog provided with settings

IS

E!-?é Survey Databases
S5 ATCS Test
?é Lorton Road
?é Mew Boston
?é Mew Haven Test
55 SITEMG
BQ Import Events
Input and Output Files -5 Tract 1 Bndy.fbk
* Input Files -9 Survey Queries
— Least Squares Analysis Input File created with station-to-station observations (does not
consider side shots) o[ i
— File called “network.lsi” 17 Properties...
— Can add or make changes to Input File in a text editor using “Edit Input File” command
— Can process the Input File to calculate the adjustment and create a least squares
network adjustment file (network.adj) and a least squares network output file
(network.lso).

Insert into drawing

Remove from drawing...

Report tolerance errors

(0]
=
©
C
<C
od
)
e
C
()
=
e
92}
2,
©
<C
-
[
o
3
)
Z

- OUtPUt Files [m] Net Automatic update
— Network.Ilso [ 8 IEI Figy E Update network
— Can view the Output File using the “Display Output File” command -5 Figu
| Reset...
w £% Sun
EE] Sur Survey Command Window...
Traverses _ & B Equipment
= Create based on Control Points BRE sin Import ’
- Righttclicll( on “Travgrse” gpder desire.d Network and ghoose “New” = &4 Figure Pref Edit field book...
* Requires mmall Station, Initial BS, station range and Final FS i ACME B Exportfield book.
= Can have multiple Traverses per Network B atcs | = T ——
= Perform Traverse Analysis -2} Class
— Right-click on the traverse and choose “Traverse B cvil4 3 Delete.. Create input file
Adjustments” i : ‘ - Editinput file...
. 1 L4
_;_; . AnalySIS Types A Least Squares Analysis M | Process input file...
C — Compass Rule o, m. Display output file...
q) - El’anslt Rule X : 3 = - '?g Update survey database
— randall Rule [r— Value L
E — Least Squares | | Ee
((b) Bﬁ Input
(@)) - Create input file Yes
CU Updating the Network - Input file name Metwork -
c = After running analyses, update the Database to reflect the - Metwork adjustment type 2-Dimensional -
© changes. o =-%% Procedure
E — Adjustmer_1ts made to Points in the Survey Database and e B 3
any resulting linework ]
© - Coordinate convergence 0.03280840
e - Confidence level 95% confidence El
© - Perform blunder detection [¥] Yes .
D - Update survey database Yes
()
P
S [ Ok ] l Cancel ] ’ Help J




1. Create a Traverse
a. Under “Class Database”, expand “Networks”, then “TRACT-1", right-click on “Traverses” and hit “New”

b. In the dialog that appears set the name to “Control”
For the Initial station, type in 6 and the rest of the dialog should populate. Check to make sure the values match the

screen shot below:
5

C.

A MNew Traverse

Property Value
Mame I'iLoop
[ Description
Initial Station g
[ Initial Backsight 5 ||
Stations 8-17,33,35,36,7,5 ]|
el

[ Final Foresight

[ 0K I | Cancel | | Help

2. Run Least Squares Analysis

a. Right-click on the “TRACT_1” Network and choose “Least
Squares Analysis”, then “Perform Analysis”
b. Set “Network Adjustment Type” to “2-Dimensional” and hit “OK”

c. Examine the files that are created

3. If yellow warning signs appear under the Network, right -click
on each subsection and hit “Update”

4. Zoom in and Examine Error Ellipses
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Editing Fieldbooks
= Can edit the imported Fieldbook in a text editor
* Right-click on desired Network and hit “Ediit Field book”

Editing Data in the Database
= Changes are cascading
— Changes to setups will change all related observations and Figures
— Changes to observations will change all related Figures
— Etc...
= Editin Item View
—  Click on any category (Control Points, Setups, etc...) and use Item View as editor

— To save back to the database, hit the = button at the top of the ltem View.
— To see changes appear in the drawing, right-click on the Network or Figures and hit
“Update [item]”
* Use Panorama
— Right-click on any category (Control Points, Setups, etc..) and hit “Edit”

— To save back to the database, hit the E button at the top right of the Panorama
— To see changes appear in the drawing, right-click on the Network or Figures and hit
“Update [item]”

El

Station Point

ﬁé—f Survey Databases
ﬁfé Lorton Road
fé Mew Boston
ﬁ'é SITE MG
-5 Subdivision
BQ Imnport Events
Q Class Survey.fhk
- T Survey Queries
E—JIH Metworks
=I5 LINEWORK
IEI& Control Points
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IEIE Directions
- R
L1 Traverses

[IH] Metwork Groups
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1. Create New Database and Network (see page s 19 and 27 for additional instructions)
a. Database Name = Subdivision
b. Network Name = Linework

2. Create a New Drawing (see page 7 for additional instructions)
a. Use “_AutoCAD Civil 3D (Imperial) NCS.dwg” and save as C:\Civil 3D Projects\Civil 3D 2019 Survey\Linework.dwg

3. Import Fieldbook
From the ‘Home’ tab of the ribbon, choose “Import Survey Data”
Choose the “Class Database” Survey Database and hit “Next”
For the “Data source type”, choose “Fieldbook” file.
Browse to C:\Civil 3D Projects\Civil 3D 2019 Survey and choose “Class Survey.fbk”, hit “Open’, then hit “Next”.
Choose “Linework” Network and hit “Next”
Set “Show Interactive Graphics” to “Yes”
Set Current Figure Prefix Database to “Class”
Uncheck Process Linework During Import
Make sure “Insert Network Object” and “Insert Figure Objects” are both set to “Yes”
Set “Insert survey points” to “No”
Hit “Finish”
Watch the preview as the data is added.
4. Edit an Observation
a. Click on “Survey Points”
In the Item View, scroll down to point number 313, right-click and choose “Edit Setups that Observe”
In the “Distance” column, change the value for Point 313 to 60.5.
Hit the “Save” button in the Panorama to commit the change

Back in the “Survey” Toolspace tab, click on “Figures” and hit “Update”. The building line will now follow the new
location of the point
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ﬁ Station: 3, Backsight:2

Angle Angle Type Distance Distance ... Vertical Vertical Ty...
340.0825 Facel Angle 91.956 Slope 89.2148 Vertical A |~ |
337.3908 Facel Angle 91.609 Slope 89,1216 Vertical A
333.5347 Facel Angle 91.407 Slope 89.1618 Vertical A
331.2018 Facel Angle 112,039 Slope 89,1721 Vertical A
279.5711 Facel Angle 61.851 Slope 89.4143 Vertical A
2284057 Facel Angle 51.821 Slope 893810 Vertical A
3335349 Facel Angle 41,403 Slope 89,1639 Vertical A
3420834 Facel Angle 41.845 Slope 89.0805 Vertical A
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Linework Codes in Point Description

= Descriptions matching an entry in the Figure Prefix Database automatically generate a
figure (linework)

* Linework Commands entered in Point Description (MCS, C3, etc...)

* Commands and descriptions separated by specified character (usually a space)

Linework Code Sets
= Specify and Interpret field code syntax for automated linework creation
= Created and Organized in the ‘Survey tab of the Toolspace
— Right-click on “Linework Code Sets” and choose “New”
* Customize codes to match company/survey standards and practices
= <Space> is recommended Feature/Code delimiter
* Dialog provided with settings

Horizontal and Vertical Figure Offset Codes

- ! . A . [ Property Value
* Indicate parallel, relative vertical and/or horizontal offset(s) for a figure . =
. . L 9--1&1 Information -
* Codes entered into Point description B E=== —
— Parallel figure begins at the point where the H or V codes are given e e et
— Can insert multiple horizontal and vertical offsets from one point/figure Description
— Can use SO (or other chosen code) to stop one or more offsets at a certain point along =-[4} Coding Methods
the figure. - Feature/Code delimiter <Space>
- Field code escape /
- Startin comment mode [ No =

'259 1359175.4916,761359.0973,126.1697,ew bc
'260,1359187.2916,761317.6974,126.1697,ew
1261,1359192.5616,761287.3474,126.1697,ew

1271 1359060.4619,761382.3572,126.1697,ew

'272 1359093.4118,761386.2072,126.1697, ew

'273 1359155.9917,761380.3372,126.1697,ew rpn259 ec
1274,1359880.2402,761370.7673,0.0000,brn cls

.275 1358737.5325,761491.9970,131.4197,epr

'276 1358658.2027,761431.1071,131.3097,epr

t‘ R o T M Il
A  Edit Linework Code Set
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- Automatic begin on figure prefix match Yes
- [%7 Special Codes

- Begin B
- Continue C
_______________________________________________________ - End E i
'1 500,490,100.01,BC1 B H-4 V.1 H.5 H.75 V-.7 H2.25 V-.35! L as
: - Horizontal offset H
.2,500,500,100.02,3(:1 : -+ Vertical offset v
: : - Stop offsets 50
'3,500,510,100.03,BC1 i I;ff‘z e S
h h Recall point RPN o
14,500,520,100.04,BC1 i o] [ [
15,500,530,100.05,BC1 e
! | G e E - ) O
6,500,540,100.06,BC1 ! 2 3 4 5 6 7 8
! Y/ BHHA-6 B fg’\ az B 17 ok Bran-a5 =3 -.fr\_-r} 66 F100-67 %(100.08
17,500,550,100.07,BC1 SO ! G- 05 B oBL] SBC! ~B pBCl S0 BU
'8,500,560,100.08,BC1 I N1
e H ~— 100.01
! BC1 B H—4 V.1 H5 H.75 V—.7 H2.25 V—.35




1. Create Linework Code Set
a. Inthe “Survey” Toolspace tab, right-click on “Linework Code Sets” and choose “New”
Enter “Class Set” as the name
Change the Begin Curve code to “PC”
Change the End Curve code to “PT”
Change the Point on Curve code to “POC”
Hit “OK”
g. Right-click on new Linework Code set and choose “Set Current”

~ooogw

2. Create a New Drawing (see page 7 for additional instructions)
a. Use“_AutoCAD Civil 3D (Imperial) NCS.dwg”
b. Save the new drawing as C:\Civil 3D Projects\Civil 3D 2019 Survey\Offset example.dwg

3. Import ASCII file with Linework Codes and Offsets
a. From the ‘Home’ tab of the ribbon, choose “Import Survey Data”
Choose “Class Database”
Choose ASCII file, PNEZD comma-delimited and browse to C:\Civil 3D Projects\Civil 3D 2019 Survey\Offsets.txt
Create a new Network called “Offsets”
Set “Show Interactive Graphics” to “Yes”
Set Current Figure Prefix Database to “Class”
Make sure “Insert Network Object” and “Insert Figure Objects” are both set to “Yes”
Set “Insert survey points” to “Yes”
Hit “Finish”

mTa@~mooo00T

4. Examine Data
a. Examine data in the Survey tab
b. Examine data in the drawing using ORBIT or Object Viewer

BC1(1)
. BC1(2)

N BC1(3)

—BC1(4)
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Help Menu

Accessed from the “Help” pull-down menu or by hitting F1: Online Resources

e  Autodesk Civil 3D Website
e  http://www.autodesk.com/civil3d

Tutorials
Accessed from the “Help” pulldown menu:
e  Information about Civil 3D including:

—  Overview and features
—  AutoCAD Civil vs. AutoCAD Civil 3D

—  White Papers and Customer Success Stories
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yword or phras

What's New
—  Support knowledge base

Getting Started

—  Partner and add-on products

Tutorials — etc.

e Autodesk Civil 3D Discussion Group

http://discussion.autodesk.com/
Learning Resources —, Choose Civil 3D

e  User and Autodesk forum:
e  Large database of Q&A
®  Ask a question and receive answer from users, resellers, and Autodesk personnel

keyword or phrase .'1 ‘.__ Sign In -
Help
What's Mew The CAD Geek Blog

e  http://www.TheCADGeek.com

- e  Tips and tricks, how-to videos, and industry insights for Autodesk related products;
Tutorials AutoCAD, Civil 3D, and Map 3D.

Getting Started

Video
e Other Classes

e  Other classes offered by CADD include:
—  AutoCAD Civil 3D Level ll: Road Design
—  AutoCAD Civil 3D Level ll: Visualization
—  AutoCAD Map 3D Introduction
—  AutoCAD Level l/ll
—  AutoCAD 2016/2017 to 2018 Update

Learning Resources
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